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Overview

The Manage the HMGP Project Application process allows Grantee Mitigation
staff to create a record for each HMGP project application after a disaster
declaration.

Each project application record contains information about the project and the
applicant. Table 6-1 provides an overview of the Manage the HMGP Project
Application process.

NOTE: In NEMIS HMGP, the terms "Application,” "Project,” and "Project
Application” are used interchangeably. Generally, however, the term
"Project” is used after the application has been approved.

Table 6-1: Manage the HMGP Project Application

‘ DESCRIPTION

Purpose To manage information about each project application and
applicant

When does it start? | After disaster information has been entered by FEMA Regional
Staff

Who does it? Grantee Mitigation Staff

NOTE: If the Grantee does not have access to NEMIS
HMGP, the Grantee must contact the Regional Mitigation
Staff to request access. Although the Grantees are
responsible for entering the project application
information into the system, FEMA Regional Mitigation
staff may also enter the information.
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‘ DESCRIPTION

How is it done? Execute the following tasks:
Task 1: Create a New Project Application

Task 2: Enter Applicant Information

Task 2A: Enter Grantee Information

Task 2B: Enter Sub-grantee Information

Task 2C: Enter Sub-grantee Mitigation Plan Information

Task 2D: Enter Sub-grantee Application Preparer Information
Task 3: Attach Problem and Risk Data

Task 4: Enter Project Information

Task 5: Enter Work Schedule

Task 6: Enter Cost Estimate

Task 7: Enter Match Sources Funds

Task 8: Enter Cost Effectiveness Information

Task 9: Attach Maintenance Assurance Information

Task 10: Enter Public Notice Information
Task 11: Attach Documents

Task 12: Enter Eligibility Review Information

Task 13: Enter Property Site Inventory Information

Task 14: Enter Latitude and Longitude Information

Task 15: Enter Authorization Information

Task 16: Edit an Existing Project Application

Task 17: Verify and Submit a Project Application
Task 18: Zero Out a Project

Task 19: Copy an Un-submitted Project to a More Recent
Disaster

There is no limit to the number of project applications you can enter in the
system. In fact, this is a good way to compare projects before setting priorities
among the different projects.

CAUTION: Once a project application record has been created in NEMIS HMGP,
the record is permanently stored in the database. There is no "delete"
feature.
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HINT: Create a new record for each new project - do not attempt to edit an
existing project record to create a new one.

The project application can be edited until it has been approved or denied by
FEMA. After denial or approval, the Grantee can only attach documents to the
project application. To make other changes to an approved or denied project
application, follow the instructions in Unit 8: Manage Amendments.
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Information Requirements

Some project application information will be entered directly into the system's
data fields. Other information is entered into the system by attaching or scanning
documents that are linked to the project application record. Before you begin the
tasks in this unit, ensure that the following documents contain all the required
information or are ready to be attached or scanned.

e Overall project information, including Federal Information Processing
Standards (FIPS) code (FEMA will assign one if not included);

e Sub-grantee and contact name;
e Location and description of project;
e Cost estimate spreadsheets and documents;

e Cost-effectiveness of the project comparing the cost to the anticipated
value of reductions in future damage,;

e Work schedule;

e Alternative projects considered and justification for selection of the final
project;

e Environmental considerations, which may be documented using the
HMGP’s Environmental Considerations Questionnaire;

e Report describing the environmental impact of the proposed action with
supporting documentation, such as maps and technical reports;

e Compliance assurances, including National Flood Insurance Program
(NFIP) participation and last CAV date;

e Decision-making process, including alternatives considered, selection
made, and reasons for the decision;

e Project description (you may also type this directly into the Project
Description field, if less than 4,000 characters);

e Benefit-Cost Analysis (BCA);

NOTE: The following problem and risk analysis documents may be contained in
the local Multihazard Mitigation Plan.

e Problem description, including 25 years of damage history; and
¢ Risk and cost-effectiveness data.

HINT: In addition to the above documents, other supporting documentation
(e.g., maps, blueprints, photographs, plats and reports) can be attached
or scanned.

Page 6-6 NEMIS HMGP User Manual MR 3.18.02



December 2015

Unit 6: Manage the HMGP Project Application

Information Available for Review

FEMA Regional Mitigation staff can access HMGP Project Application
information entered by Grantee Mitigation staff. Table 6-2 lists where project
application information can be found in the system.

Table 6-2: Manage the HMGP Project Application

INFORMATION AVAILABLE FOR REVIEW LOCATION IN NEMIS

Project applicant information

Mitigation >Projects>Application
Development>Applicant Information tab

Problem and risk data information

Mitigation>Projects> Application Development
>Problem and Risk Data tab

Project information

Mitigation >Projects>Application Development
>Project Info tab

Work schedule

Mitigation >Project> Application Development
>Work Schedule tab

Cost estimate information

Mitigation >Projects> Application
Development >Cost Estimate tab

Sources and details of non-Federal funding

Mitigation >Projects> Application
Development >Match Sources tab

Cost effectiveness information

Mitigation >Projects> Application
Development >Cost Effectiveness tab

Maintenance assurance

Mitigation>Projects> Application Development
>Maintenance Assurance tab

Public notice

Mitigation>Projects> Application Development
->Public Notice tab

Supporting project documentation

Mitigation>Projects> Application Development
>Attachments tab

Reviewer's name and reviews conducted

Mitigation>Projects> Application Development
>Eligibility Review tab

Property owners and details

Mitigation >Projects> Application
Development >Property Site Inventory tab

Property latitude and longitude

Mitigation>Projects> Application Development
->Lat/Lon tab

Preparer information and authorized
Grantee’s name; Authorized Applicant
Agent and Authorized Grantee Official

Mitigation>Projects> Application Development
>Authorization tab

Review application for deficiencies and to
ensure eligibility

Mitigation>Projects>Application Development
-> Verify Button

Submission date and authorization
information

Mitigation>Projects> Application Development
>Authorization tab
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Task 1: Create a New Project Application

1. On the MITIGATION menu, click Projects > Application Development. When
the Application development screen appears, then select New (Figure 6-1).

§&MEMIS / HMGP Version 3.16.00 04,/26,/2013
Fil= Disaster | Projects Funding Plans Repository  Applications  Admin wWindow  Help

Application Development:

g Eligibility Determination 3
Appeals
Field Survews

Management
Checklist
Closeout
Q‘ﬁsalect Project: Application Development Disaster 7519
Fema Proj Hr| amendment Hr| applic I | surfix| ST | Region| Project Title | |
| | 0 E | IMS | 4 |Woided Praject
| Il o I 14 [ ms] 4 |
I [ o [ 15 [ ms[ 4 |
I [ o [ [ ms] 4 |
I [ o 7 [ s 4
I [ o [m [ ms] 4
I [ o© [m [ ms] 4
I o 2o [ ms] 4 |
I [ o 2r [ ms] 4
I | O J o222 [ Jms] 4|
4 o 24 M= 4 est Project 2012 =
Prit | Expand Sort | hlewne | Ok I Cancel |

Figure 6-1: Mitigation >Projects>Application Development

2. The Create Application dialog box is displayed (Figure 6-2).

iq'-ﬂ Create Application

Diza=ster Mumber ;
Application |d

Project Amendment Mumber :

7313

23

aF.

Figure 6-2: Create Application Dialog Box

3. Enter the information listed in Table 6-3.
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Table 6-3: Create Application Dialog Box Data Fields

DATA FIELD INFORMATION TO BE REVIEWED/ENTERED

Disaster Number Read-only Disaster Number auto-filled by the system

Application 1D Auto-filled sequential number assigned by the system. You can
change the number if you use your own numbering system to
track applications.

CAUTION: This data field accepts numerals only. The system
will not accept any number higher than 9999.

Once you click the OK button in the Create Application Dialog
Box, you can no longer edit the number.

Project Read-only Project Amendment Number auto-filled by the system
Amendment
Number

4. Click the OK button. Fourteen tabs for managing HMGP Application
Development Information are displayed at the top of the page (Figure 6-3). By
default, the Applicant Information tab is displayed.

Fle Disaster Projects Fundng PlansRepostory Applations Ao Wiaow Help

B oH e B

Cholisastir ChaGrowp  Plae  MEME  Ext

“HMEPAPPLI[ATII]N: DISASTER #7519 FEMAPROD #: - APPLICATIONID: 25 AMENDMENT #:0

it |
Ir'PP"W"‘|"fﬂ""iﬂiﬂ"|Prob|ern&ﬁisk0ata |Prujecﬂnfo |WorkSchedu\e |CustEsﬂmate |Ma1@h80urces |C031Eﬂectiveness |MairﬁenanceAssurance |Pub|icNutice |Atlachmerﬁs |EliginnyReview | | | |

Figure 6-3: HMGP Application Development Tabs

HINT: Saving Project Application Information

As you enter information in the different tabs, save frequently so you do not lose
the data. You can save your work by doing one of the steps below:

On the bottom left part of the screen, click the SAVE button.
Click on another tab.

On the bottom right part of the page, click the CLOSE button. You will be
prompted to save changes.
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Task 2: Enter Applicant Information

On the Applicant Information tab (Figure 6-4) you can perform the following
sub-tasks:

Task 2A: Enter Grantee Information

Task 2B: Enter Sub-grantee Information

Task 2C: Enter Sub-grantee Mitigation Plan Information

Task 2D: Enter Sub-grantee Application Preparer Information

NEMIS / HMGP Yersion 3.16.00 04/26/2013

File Dissster Projects Funding Plans Reposiiory  Applcations Admin Window Help

H 8 B &« [

Cholisuter ChgGrawp  Phwe  MEMIS  Exit

Q%HMGP APPLICATION: DISASTER #: 7519 FEMAPROJ#: - APPLICATIONID:25 AMENDMENT #: 0
Authorization |

ﬂﬂﬂliwnﬂ"fﬂfmatiﬂﬂ|Proh|em&R\skDa1a |Prmedlmo |WorkSchedu\e |C051E51\ma13 |Match80urces |C031Effec1iveness |Ma\menanceAssurance |PublicNo1ice |Aﬁachmerﬂs |EIig\b\IilyReview Pronerty Site Ientary |Lan‘|_on|
~Grantee

I Stete Code I_ Courty Code : l_
L e :I I More Grantee Info ..

| SAate Code! ’_ County Code: l_l—
Fins Place Code |—|
Public Erty : I—I Ware Subgrantee nfo ..
WFIP Prticition: l_L, Last CAV Date: M

~Subgrantee Mitigation Plan

when Subgrantes i3 the Grartee, no Subgrantee Migstion Plan i Edit SubarLirk. |
Plan Type: | TECEsSary.

Anrvl D | (10/00w0000 Expire [t

~Subgrantee Application Preparer

I More Preparer Info..

Save | Wetify | Submit | Lmendd Cloza

Figure 6-4: Mitigation >Projects >Application
Development >Applicant Information Tab
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Task 2A: Enter Grantee Information

1. Onthe Applicant Information tab, click the MORE GRANTEE INFO button.

The Assign Grantee screen is displayed (Figure 6-5).
2. Information about the first Grantee is displayed. Scroll down to see the

information on the other Grantees.

§® Assign Grantee | X}

Search Results

Applicant ID : | 000-00000-00
County:| 0O [Statewide
Place Code: | 0 [tatewide

Name : Statewide

Taxid: |

CID Number : [289339 - Statewide ~] e ]
Applicant Description : [State Emergency Management Agency Edit Contact

Private Non-Proft: (" Yes * No
Add Contact

- Delete Contact
Contact Title -

Contact Name
ADAMS MANAGER Save |
ABRIGG LARRY MANAGER 0K |
IATE BRUCE PRINCIPAL =
d ! . = Cancel |

Figure 6-5: Grantee Search Results

HINT: The Grantees that are available for selection are those to which your User
ID is linked. If the desired Grantee is not displayed, complete the steps in
Unit 3, Task 8: Enter User to Grantee Link Information.

3. Make sure that the Grantee you wish to select is displayed on the screen.
Click the OK button to select that Grantee. Select the Save button.
4. The Grantee section of the Applicant Information tab now displays the

Grantee information (Figure 6-6).
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File Disaster Projects Funding Plans Repository  Applications  Admin  Window  Help

”E@Ej%iﬁ

Chg Disaster ChgGroup  Flans HERIS Exit

& HMGP APPLICATION: DISASTER #: 7519 FEMAPROD #: - APPLICATIONID: 12 AMENDMENT #: 0
Attachments I Eligibility Rewviesn: | Property) Site Inventors: | Latfan | Authorization |
Applicant Information |Problem&Risk Dt | Project Info |Work Schedule | Cost Estimate | Metch Sources | Cost Effectiveness | Mairtenance Assurance | Public Netice |

—Grantee

I!Statew-lde State Code IE County Code | 0 I!Siatevwde

Fipz Place Code I a Ftatewwde

—Subgrantee

State Code : I_ County Cocde I I

Fips Place Code : I I

Public Ertity : | | More Subarartes Info ... |
NFIF Participation : w|  LastCAY Date: | 00/00/0000

—Subgrantee Mitigation Plan
when Subgrartee is the Grantee, no Subgrartee Mitigation Plan iz Edit Subar Link.. |
Plan Type I NEcEsSSary

Apry Dt I 00000000 E:pire DOt I

—Subgrantee A Preparer

I tdore Preparer Info... |
Save | Werify | Subrmit | A | Cloge |

Figure 6-6: Applicant Information Tab with Assigned Grantee

5. On the bottom left part of the Applicant Information tab, click the SAVE
button.
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Task 2B: Enter Sub-grantee Information

1. Onthe Applicant Information tab, click the MORE SUB-GRANTEE INFO
button. The Assign Sub-grantee screen is displayed (Figure 6-7).

§@# Assign Subgrantee E2

Enter Criteria
Applicart D | il

County : |
Place Code : | |
Public Entity D | |

Name : |
Taxd: | Private Non-Proft: " Yes (" No
CID Number : | =]
Applicant Description : |

Contact Name Contact Title

Figure 6-7: Assign Sub-grantee

2. Click the SEARCH button. Information about the first Sub-grantee is
displayed. Scroll down to see the information on the other Sub-grantees

(Figure 6-8).
Search Results
Applicant ID: [ 001-01520-00 Update ID Istate ws = Criteria |

Courty:| 1 jadams

Place Code:| 1520  |Anna Add |
Public Ertity ID : | | J Delete |

Name : jAnna
Taxld: | 1234 Private Non-Proft:  Yes ' No
Add Contact |
CID Number : 280209 - Adams County * =~

Applicant Description : ¥3P2 TESTING_01-15-03 Edit Contact |
hd Delete Contact |
Cortact Name Contact Title

SLATE |S. L [HMD BRe |
oK I
Cancel |

Figure 6-8: Sub-grantee Search Results
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3. If the desired Sub-grantee is already listed, make sure that the Sub-grantee
you wish to select is displayed on the screen. Click the OK button to select
that Sub-grantee. Proceed to Step 5.

4. If the desired Sub-grantee is not listed, complete the following steps to add a
new Sub-grantee.

a. On the Assign Sub-grantee screen, click the ADD button. The
County/Place Code List is displayed (Figure 6-9).

§# County/Place Code List E3

* County Code  Please contact your FEMA regional HMO if you cannot locate the proper subgrantee by either
¢ Public Entity FIPS County and Place code or by a Public Entity Id.

Courty Code County Name | Place Code I Place Name |
1

Adams Adams (County)

520 }Anna

T
| 1 }Adams ]1 0420 Fa'“
| 1 Pl.dams |1 1770 Fanhage
| 1 F\dams ]14540 F““e“’a’e
| 1 }Adams ]1 5380 Franfield
hd
Subdivision Name | o | Place

Cancel |

Figure 6-9: County/Place Code List

b. If the new Sub-grantee is associated with a place (e.g., a town within a
county), click the County Code radio button. A list of Federal Information
Processing Standards (FIPS) County/Place Codes and Names is
displayed.

HINT: Click the County Name or the Place Name column heading to sort the
contents alphabetically. It may take the system a few minutes to complete
this process.

Page 6-14 NEMIS HMGP User Manual MR 3.18.02



December 2015 Unit 6: Manage the HMGP Project Application

CAUTION: When searching for a county in the list, be sure to select the record
identified with the county in the Place Name column. Since the table
repeats the county name and the list under Place Name is
alphabetical, this is seldom the first row when you scroll down to the
records for that county.

5. If the new Sub-grantee is a public entity (e.g., a building within a town within a
county), click the Public Entity radio button. A list of Public Entity Names, with
their corresponding ID, County/Place Code and Name is displayed (Figure 6-
10).

mPublic Entity/County/Place Code List
" County Code  Please contact your FEMA regional HMO if you cannot locate the proper subgrantee by either

FIPS County and Place code or by a Public Entity Id.

9 ty
Public Entity Name | o | County | county ca Place =
DELTA REGIONAL MEDICAL CTR ! Washington Washington (Courty)
TRACE REGIONAL HOSPITAL 0015 [Chickasayy 17 [Chickasaw (Caunty)
DKOLONA AMBULANCE SVC 00017 Chickasaw 17 [Chickasaw (Courty)
HILLCREST HOSPITAL 00014 KCalhoun 13 Calhoun (County)
MISSISSIPPI VALLEY STATE UNIY N001C  Leflore 83 Leflore (County)
[sLCORN STATE UNIVERSITY 0025 [efferson 63  Lefferson (County) =
< 7 | LI_I
|

Ok I Cancel

Figure 6-10: Public Entity List

6. Select the row in the list that applies to the new Sub-grantee. Click the OK
button.

7. The Assign Sub-grantee screen now displays the following read-only
information about the selected Sub-grantee (Figure 6-11):

e County/Place or Public Entity Information
e Sub-grantee's Name
e Sub-grantee's Tax Id
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mnssign Subgrantee X

search Besults

Cancel

Applicart ID: | 001-01520-00 Update 1D | state - [ ms &l
Courity :| 1 l&dams
Place Code:l 1520 lﬂ.nna Add
Public Entity D : | | Delste |
Name:l&nna
Taxld: | 1234 Private Mon-Prafit: © “es * o
Add Contact |
CID Mumber ; |280209 - Adams Courty * |
Applicant Deseription : 3 15.04 TESTING_01-2-13 Edit Contact |
Delete Contact |
Contact Mame Cortact Title
ifs |

Figure 6-11: Assign New Sub-grantee

8. In the Private Non-Profit field, click the Yes or No radio button.

9. In the CID Number field, select the Sub-grantee's Community Identification
Number from the drop-down list.

10.In the Applicant Description field, enter a brief description of the Sub-
grantee.

11.To add a contact for the Sub-grantee, click the ADD CONTACT button.
The Look Up a Contact window is displayed.

12.Follow the personnel database instructions in Appendix B. You will be
returned to the Assign Sub-grantee screen.

13.Click the OK button to finish adding the new Sub-grantee.

14.The Sub-grantee section of the Applicant Information tab now displays
the Sub-grantee information (Figure 6-12). The County/Place Code that
you selected is displayed in the Fips Place Code field.
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—Grantee

%HMGP APPLICATION: DISASTER #: 9047 FEMA PROJ #: - APPLICATION ID: 8 AMENDMENT #: O

Applicant Information | Proklem & Risk Data Project Info | Wiork Schedule I Cost Estimmate I Match Sources I Cost Effectiveness I Mairtens

Ftatewide State Code : IE County Code : I a

Fipz Place Code :I a IStatewide

Fta‘tewide

hore Grartee Info ... |

—Subgrantee

FIAY SPRINGS CITY HALL State Code : IMS Courty Code I B1

I.Jasper

Fips Place Code : I 99061 }Jasper [County)

Public Ertity : I 04C53 FIAY SPRIMNGS CITY HALL

MFIP Participstion : I vl Last CAY Date : I 0000000

More Subgrantee Info ...

Subgrantee Mitigation Plan
|+ Enable Manual Entry of Plan Data

Figure 6-12: Applicant Information Tab with Assigned Sub-grantee

15.1n the NFIP Participation field, select Yes or No.

16.1n the Last CAV Date field of the Sub-grantee section, enter the date of the

last Community Assistance Visit.

17.0n the bottom left part of the Applicant Information tab, click the SAVE

button.
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Task 2C: Enter Sub-grantee Mitigation Plan Information

NOTE: To use the Enable Manual Entry of Plan Data feature, see Unit 4 Task 3.

Manually entered plan information will not be reflected in the plan
report.

1.

If there is an approved plan, the Plan Type, Approval Date and Expire Date
information of the plan are displayed in the Sub-grantee Mitigation Plan
section of the Applicant Information tab.

If there is no approved plan, as in the example below, the Plan Type,
Approval Date and Expire Date fields are empty. A warning message that
there is no approved plan is displayed in red (Figure 6-13).

T
—Subgrantee

PELTA REGIOMNAL MEDICAL CTR State Codle IMS County Cocle : I 151 r/\‘ashing‘ton

Fips Place Code : | 99151 IJ‘JaShing‘ton (County)
Pullic Entity : | 00011 PELTA REGIONAL MEDICAL CTR

MNFIF Participation : I vI Last CAN Date : I 000000

More Subgrantes Info ...

—Subgrantee Mitigation Plan

Enable M. | Entry of Plan Data
r Enableiianug = an & Mo approved Subdgrartes Multihazard Mitigstion Plan for this subgrantes. Edit Subagr Link..
Plan Type I R ———

Aprvl Ot I 00000000 Expire Dt I oF initiative projects.

There must be an mitigation plan with & walid approval date BEFORE the
dizaster declaration date before any projects can be approved for regular

—Subgrantee Application Preparer

FMITH A tore Preparer Info... |

t anually entered planz information will not be reflected in the Plan Repart

Figure 6-13: No Approved Sub-grantee Mitigation Plan Warning

3. To enter Sub-grantee Mitigation Plan information complete the following

steps:
a. Click the EDIT SUBGR LINK button on the right part of the screen. The

MT Sub-grantee Mitigation Plan screen displays all approved plans for the
Sub-grantee (Figure 6-14).
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“MT Subgrantee Mitigation Plan E I

Apred Expire Aprvl Plan
Current Date Date Type Type Rev.Ho Plan Hame

CITY OF AhRS %3P2 TESTING PLAN

o Flan(z) meeting approval date criteria are highlighted in yellow
Justification:
LMH Rev. Mo, 0 Approval STD Dated 0610572002 -EGARREN-09M06/2011 17:35 GMT ;I

Tao append to the justification, prezs the Append button. K

Figure 6-14: MT Sub-grantee Mitigation Plan

b. Highlight the Mitigation Plan that you wish to link to this project application.

c. Click the APPEND button. The Comment Editor is displayed (Figure 6-15).

§® Comment Editor E3

Old Comments:

L

I

Add Hew/Additional Comments Below:

This plan is approved | _AJ

Spell Check
Print

oK

Cancel
Character Limit
| 4000

~| Characters Avail

The ‘characters avail' accounts for the user name and date appended to the comment | 3948

Figure 6-15: Sub-grantee Mitigation Plan Comment Editor

d. Inthe text area, add comments relative to the selected plan, or add a
justification if you are changing the plan currently linked to the Sub-

grantee.
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e. Click the OK button. The comments are now displayed on the MT Sub-
grantee Mitigation Plan screen. The system appends your User Name, the
date and time to the end of the text. (Figure 6-16).

]|

*MT Subgrantee Mitigation Plan

Aprued Expire Aprvl Plan
Current Date Date Type Type Rev.Ho
=D LhiH u] CITY OF AMNMA W3P2 TESTING PLARN

Plan Hame

o Flan[g] meeting approval date criteria are highlighted in yellow
Justification:
LiiH Rew. Mo. 0 &pproval STD Dated 06/05/2002: -EGARREN-09/06/2011 1735 GMT ;I

[~

To append to the justification, press the Append buttan.
aK | Lancel I

Figure 6-16: MT Sub-grantee Mitigation Plan Comments

f. Click the OK button. The Sub-grantee Mitigation Plan section of the
Applicant Information tab now displays the mitigation plan information
(Figure 6-17).

g. Close and reopen the application. Notice that in the example below the
red warning message stating that there is no approved plan is not

displayed.
MIS [ HMGP Yersion 160 04,7601
Tisaster Projacts Tundng Plans Reposory  Appleations Advin Window  Help
@ 8 e w
" S
PamLl Proisil A lion Dereiopment icaster 15
[\ HPMGP APPLICATION: DISASTIR & 7519 FEMAPRO14: - APPLICATION ID: 25 AMENDMENT &:0
Authorizaton |
mmlmamﬁm |mjec1heo |w«ks«m ]cmtm: |--“" |t‘o!t[ i | Assurance Public Notice | Attachmarts Iuﬁmmm | | [
Grantes
[rice m.-.rm--[ﬁmmcw [ ﬁ.ifm
P Foce Cose:{ 50,15 e Mare Grastee ki .
fora m.-.m-x-.-[ﬁm.e,m 1 m
rulmm.[ [T
Pusic Eniey: [ Isors Sutsyantes nfo I
WFP Parcistion [ ] Last CAV Dt [CEITARONT
Subypantee Mitiyation Plan
Plan Type: [L0CM M Meption P Plan Thie f-tmm Testrg Pl -E‘M“"L'"'J
Aprdt | DAY ansao7
Subgrantee Application Proparer
[E Mosa Puoguoeet ke
swve | veity | sumt | tome |

Figure 6-17: Applicant Information Tab with Sub-grantee Mitigation Plan

4. On the bottom left part of the Applicant Information tab, click the SAVE
button.
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Task 2D: Enter Sub-grantee Application Preparer Information
1. Onthe Applicant Information tab, click the MORE PREPARER INFO
button. The Look Up a Contact screen is displayed (Figure 6-18).

Enter Criteria:

First Middle Last search |
Name: | | [ Pt
Contact ID:| 4[
Nickname: | Prefix: | | Suffix: | | dd
Title: |
Organization: | _|
Address 1:
Address 2: |
Street Num: |— Street Name: |
Unit Type | Unit Num:l
City: | State:| x| zIp:| 2 |
Directions: |
Note: |
Carrier Code: |— USPS Bar Code: |—
Locatn Code: [_ Longitude:l Latitude: |
EMail: |

This information is subject to the Privacy Act of 1974.
Area| Phone | EXT | PIN | Area| Phone | EXT| PIN |

Figure 6-18: Look Up a Contact

HINT: To speed up the search process, enter information in as many fields as
possible before clicking the SEARCH button. Appendix B provides
instructions for selecting a name from the personnel databases.

2. Scroll down the search results, making sure that the preparer name for this
project application is displayed.

3. Click the OK button. The Sub-grantee Application Preparer section of the
Applicant Information tab now displays the preparer information (Figure 6-19).

[ T
Subgrantee ication Preparer

[ JEMITH, A L
Save | ety | Submit | Amend | Close

Figure 6-19: Sub-grantee Application Preparer

4. On the bottom left part of the Applicant Information tab, click the SAVE
button.
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Task 3: Attach Problem and Risk Data

1. Click the Problem & Risk Data tab (Figure 6-20).

Y ¢ Ele Dissster Projects Funding Flans Repository  Applications  Admin Window  Help

LE..2. & &

tor ChaGrowp  NEMIS Exic

Applicart Information Problem & Risk Data | ProjectInfo | Work Schedule | Cost Estimate | Match Sources | Cost Effectiveness | Maintenance Assurance | Public Motice | Attachments | Eliginility Review

1. Problem Description
Describe the hazaids and fisks to life, safety and impioved property that you are iying ta solve. Include at least 26 years damage history.

Abtach/Scan Documents Wiew

2. Decision Making Process

Deseribe the community's decision making pracess, inchuding
the altemnative solutions considerex ich proposal is the
community's preferred solution? Why?

Attach/Scan Documerts View

Details may be viewed in the Eligibility Review/Eny Checklist tsb

3. Risk and Cost Effectiveness Data

Provide detailed data to assist State and FEMA to detemine if project is cost-sffective (2.0., damages from disaster events,
frequency of the events, average faciity cceupancy, type of buildings to protect, etc.)

Attach/Scan Documents iew

Only one Document or Image can be attached to ach tem, please ensure that it contains all of the irformation needed

Save \erify | Submit |

Figure 6-20: Mitigation > Projects > Application
Development > Problem and Risk Data Tab

2. Click the ATTACH/SCAN DOCUMENTS button for each of the three sections:

e Problem Description
e Decision Making Process
e Risk and Cost Effectiveness Data

CAUTION: Attachments cannot be deleted once they have been added to NEMIS

HMGP. Please make every effort to limit the file attachment size to less
than 1 GB.

CAUTION: All three documents must be included with the project application
before it can be approved by FEMA. The documents may be attached
after you submit the project application.

3. You are strongly urged to read and follow the instructions in Appendix A:
Attach/Scan Documents.

4. In the Decision Making Process section, the Alternative Names box will not
display any alternative solutions until they have been entered in the Env
Checklist sub-tab under the Eligibility Review Tab (Task12B: Enter
Eligibility Review Information). If alternative solutions have been entered, the
Alternative Names box will display the names of the alternative solutions.
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Task 4: Enter Project Information

1. Click the Project Info tab (Figure 6-21).

o Bl Demter Propcts Eedeg e feoutony pkosion  Ade gindoe e =18 x
E & & W
ot G W
Agpbcart ioemation, | Pokien £ FskDatn Project Info |vork scheie | CostEsmate | Moton Sowrses | ComtErmectveness | Mamtsnance Assurance | Pusic botce | Attachments | Exgbary Fevew | | | Arermaton |
Prapoct T [ = e
i Do
New Dedete
Puoioct Type | C | & cdet | Hazed Type
Project 2 Project
Coxde Daserighion E Loy || oescrotin
1112 Tesd New3Eh 00 kel
#11  Local Mutifazied Migaton Psn
521 S sz igusnen e
J tlldn-ﬂi
e i L ——
S| e Esae

Figure 6-21: Mitigation >Projects >Project Application >Project Info Tab

2.

m Close

In the Project Title field, enter a descriptive title for the project. If applicable,

include the town name and activity in the title.

Double-click inside the Project Description field. The Comment Editor is

displayed. In the text area, enter the Project Description text. There is an

8,000 character limit.

Click the OK button. The project description text is now displayed on the

Project Info tab. The system appends your User Name, the date and time to

the end of the text (Figure 6-22).

Yo File Disaster Projects Funding Plans Reposiory  Application:

5 Admin Window Help

”E Q@ & b

Applicart Information | Proklem & Risk Deta  Project Info

Work Schedule | Cost Estimate

Project Tle : [roquisition of 10 homes in Adams County

Match Sources

Cost Effectiveness | Maintenance Assurance

~Project

i project consists o the acquistion and demolition of 10 homes
EGARREN-0S/106/201

Public Notice | Aftachments | Bty Review | Promety Site |

117:48 GMT

J: Attach Doc
Yien

Figure 6-22: Project Info Tab with Project Title and Project Description
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5. Click the ATTACH DOC button. The Attach/Scan Document dialog box is
displayed (Figure 6-23). Note that the Document Type defaults to "PROJECT
DESCRIPTION."

[~ Scan a Document [v Attach a DeskTop Document

Disaster Number: | 7519 Application Id: I 2 Project Amendment Number: I 1}

Document Type: |PROJECT DESCRIPTION |

Document Name: F‘ROJECT DESCRIPTION

Archive | Cancel |

Figure 6-23: Attach/Scan Document Dialog Box

6. You are strongly urged to read and follow the instructions in Appendix A:
Attach/Scan Documents.

CAUTION: The Project Description document must be included with the project
application before it can be approved by FEMA. The document may
also be attached after you submit the project application.

CAUTION: Attachments cannot be deleted once they have been added to NEMIS
HMGP. Please make every effort to limit the file attachment size to less
than 1 GB.

7. If State Legislative Districts are identified in the project application, add them
to the Project Information screen by completing the following steps:

a. On the bottom part of the State Legislative District box, click the NEW
button. A new row with the two-letter State abbreviation is displayed
(Figure 6-24).

—State Legislative District
State District I

Mew [ Delete |

Figure-é-24: State Legislative District
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b. In the District Id column, enter a district name or number. The new State
Legislative District is now displayed (Figure 6-25).

erty Site Insventoryy

[ State Legislative District
State Cri=trict Idd

=]

| Ceeaien |

i=trict 1]

T

Armerd I

Clo=se

Figure 6-25: State Legislative District Added

8. On the bottom half of the Project Info tab, five sub-tabs are available for
adding project information.

9. The Project Type sub-tab is displayed by default (Figure 6-26).

Project Type | County Code | Congressional Distict | Commurity Names/Codes * | Hazard Type |
Project il add> | [Project
Code Description > | Description
1112 Test Novath 2008 AddAl> |
911  Locsl Mulhazard Miigation Pisn
< Delete |

921  Stete Multhazerd Mitigation Plan

< DelaleAlII
4 | Ll_l | | &
sove | verity | sumt |

Figure 6-26: Mitigation >Projects >Application Development >Project
Info >Project Type Sub-tab

To add Project Types, complete the following steps.
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a. On the left side where the Project Codes and Descriptions are listed,
highlight the row(s) you wish to select.

CAUTION: State Management Cost Codes (700.1-700.4) cannot be selected with
any other project types.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The Project Code(s) and Description(s) you selected are now displayed on
the right side (Figure 6-27).

Project i| | Project
Code  Description : d | Code Description
1112 Test Now30th 2009 Add All = | 200.1 Acquistion of Private Real Property

(Structures and Land) - Riverine

911 Local Multihazard Mitigation Plan

< Delete |
= < Delete All |
_"|_I

921  State Multihazard Mitigation Plan

1 | al |

Figure 6-27: Project Code and Description Added

c. When selecting project code 205.7B Retrofitting Private Structures — Wind
(P804) as shown below (Figure 6-28), additional system requirements will
need to be met:

Project Type | County Code l Congressional District | Community Names/Codes * | Hazard Type |
Project S nssmean M Proje o
>

Code Description = [_ﬁ(Ll Code Description
91.1 Local Multihazard Mitigation Plan Add All > 205.78 Retrofitting Private Structures - Wind (P804)
921 State Multihazard Mitigation Plan

) . < Delete
931  Tribal {Local) Multihazard Mitigation Plan
< Delete All
] T 3 < Hi 3

Save | Verify | Submit ‘

Figure 6-28: Retrofitting Private Structures
I. Itis mandatory to select the Hazard Type - Windstorms.

ii. The property site inventory will require the selection of one of the
four wind retrofit property site actions (Figure 6-29).
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Owner Info MT Property Site IPropetly Info I Flood Zone Designation | NFIP Info I Hazard Type | FIBM Info
Property ID: 1
Property Action -] Add> I Property Action Primary
Acquisition/Relocation
Add Al > I
Elevation

Floodproofed

Cther (Specify in Comments) < Delete I
Safe RoomAvind Shelter < Delste Anl

Seismic Retrofit

Wildfire Retrofit

vind Retrofit

wind Retrofit Advanced(A-P804)
wWind Retrofit Basic (B-P804)
wind Retrofit Estimated(ES-PS04)
wind Retrofit Intermediate(l-P504) =
) | =i 4| | »|

* Required before Project Closeout.

Save

Figure 6-29: Wind retrofit property site actions

lii. Under property site inventory, property info, the sections building
evaluation, building evaluation date (if answer to Building
Evaluation is YES), and substantial improvement must be selected
(Figure 6-30).

OwnerInfo | MT Property Site~ Property Info |Flood Zone Designation | NFIP Info | Hazard Type | FIRM Info | Property Site Funding | Narrative |
Property ID: 1

Age of Structure (year buit): I 1964 (e.g., 1982) Type of Residence: [ x|
Pre-Evert Fair Market Value: [ § Structure Type: [Single Family |
Parcel Number. [ Foundition Type: |Crawl Space |

Property Tax ld: | Basement ; | "I
Latitude: | 0.000000000 Base Flood Elevation: I 00
Longtude: [ 0.000000000 First Floor Elevation: [ 00 Diagram... |

SHPO Cleared: v Number of feet the lowest floor elevation of the
i T
Beneft-Cost Analysis Performed | v Damage Category : |0-49% Damaged x|
Beneft-Cost Ratio: [ 000
Click for sample lattue and longitude => _Samgle .. | Post-Mitigation - Property Use : [N ~ |
Building Evaluation: I‘r"ES vI Building Evaluation Date: ESQ?.QM 3
Substantial Inprovement: | NO "I

Figure 6-30: Property Site Inventory - Property Info - Building evaluation,
building evaluation date, substantial improvement

10.When selecting the new project type 904.1 Advanced Assistance (Figure 6-31),
additional requirements will apply:
a. This is a standalone project; no other projects can be selected with it.

b. Currently, this project type has funding limits equal to the lesser of 10 million
dollars or 25% of the locked in ceiling. If these amounts are exceeded, during
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federal eligibility cost review (Unit 7) validation messages specific to the
limiting factor and amount exceeded will be displayed. Adjustments will need
to be made to the requested cost of the project for the project to be approved
if the validation screens appear.

Project Type ICnunI:,rfode | Congressional District | Community Names/Codes = | Hazard Type |

Project
Code Description

904 1 Advanced Assislance

Project -
Code Descnption =
100.1 Pubbc Awarensss and Education (Brochure
Workshops. Videos. etc.)

101.1 Professional Education (Building Inspectors
Architects, Engineers. Contractors, etc.)

103.1 Feasibiity. Engineering and Design Studiat

g

Figure 6-31: New Project Type 904.1 Advanced Assistance

11.Click the County Code sub-tab (Figure 6-32).

Project Type County Code | Congressional District | Community Names/Codes * Hazard Type

County a Courty
Cade hame A M Code Name
0 Statewide Add Al » |

1 Adams

3 Alcorn

o Ak < Delete |
7

Attala = < Debtle
Il

< | 4 | ]

Figure 6-32: Mitigation >Projects >Application Development >Project
Info >County Code Sub-tab

To add County Codes, complete the following steps.

a. On the left side where the County Codes and Names are listed, highlight
the row(s) you wish to select.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The County Code(s) and Name(s) you selected are now displayed on the
right side (Figure 6-33).
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Froject Type  County Code | Corgeessionsl Dkt |tmmmﬂm'todzr |HuzadTmu |

County

§E§E§

| | i |
Figure 6-33: County Code and Name Added
12.Click the Congressional District sub-tab (Figure 6-34).
Project Type | Courty Code  Congressional District |Eumfnm1'ty Mames/Codes * | Hazard Type
State  District id Adds State District d
MS 1
s = Add All > |
MS 3
MS 4 < Delete |
MS 5 < DebateAl|
< | ja| <] | 2l

Figure 6-34: Mitigation >Projects >Application Development >
Project Info >Congressional District Sub-tab

To add Congressional Districts, complete the following steps.

a. On the left side where the States and District IDs are listed, highlight the
row(s) you wish to select.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The State(s) and District 1d(s) you selected are now displayed on the right
side (Figure 6-35).

Project Type | County Code  Congressional District | Community Names/Codes * Hazard Type

State  District Id : State District Id
MS 2 ; 4 s 1
WS 2 Add Al > |
S 4
MS 5 < Delete |
< Delete Alll
1] i H 1] | H©

Figure 6-35: Congressional District Added
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13.Click the Community Names/Codes*sub-tab (Figure 6-36).

Project Typs | County Code l Congressional Distict Community Names/Codes * | Hazard Type |
CI0 Numbser Community MName i’l Add > I CID Mumber  Community Name:
289399 Stabewvide
Add Al >
280309 Abbeville, Town Of _I
28M15 Aberdeen, City Of
280032 Ackerman, Town Of e
= | Uehis.ﬁﬂl
4] | Ll_' | | |

Figure 6-36: Mitigation >Projects >Application Development >
Project Info >Community Names/Codes Sub-tab

To add Community Names/Codes, complete the following steps.

a. On the left side where the CID Numbers and Community Names are
listed, highlight the row(s) you wish to select.

NOTE: For Project Types that require Property Site Inventory (PSI), only the
Community Names/Codes you select here will be displayed in the
Application Development > Property Site Inventory tab.

HINT: When a project is not easily associated with a designated area (i.e., a city,
a county, or statewide), the user should assess what area is best or most

served by the project and make a judgment call accordingly as to what
CID number should be selected from the list.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The CID Number(s) and Community Name(s) you selected are now
displayed on the right side (Figure 6-37).

Froject Twpe I County Code I Cangressional District Community Names/Codes ~ |Ha2ard Type |

CID Mumber Community Matmne ﬂ
289999  Statewide ' —
*

Add All |
280309 Abbevile, Towwn Of

280115 Aberdeen, City Of

250032 Ackerman, Town Of ﬁl
_ILI ¢ Delete f-‘«lll
3

e CID Mumber Community Mame

280209 Adams County *

« | < | i

Figure 6-37: Community Names/Codes Added
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NOTE: The CID Number in the Project Info tab identifies the community where
the proposed project activity will occur; the CID Number in the Assign
Grantee and Assign Sub-grantee screens identifies the community of the
Project Applicant.

14.Click the Hazard Type sub-tab (Figure 6-38).

Project Type I County Code | Congressional District | Community Names/Codes * Hazard Type

Hazard Desc Hazard Desc

Biclogical

ﬂ Add > |
Add All> |

Chemical
Civil Unrest

Coastal Storm < Delete |

Crop Losses
= |& De[eteAll
< | of | | 2]

Figure 6-38: Mitigation >Projects >Application
Development >Project Info >Hazard Type Sub-tab

To add Hazard Types, complete the following steps.

a. On the left side where the Hazard Descriptions are listed, highlight the
row(s) you wish to select.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The Hazard Description(s) you selected is (are) now displayed on the right
side (Figure 6-39).

Project Type | County Code | Congrezsional District | Community MamesCodes * Hazard Type |
Hazard Desc ﬂ gy Hazard Desc
Bilogical S—
Add Al >

Chemical 4|
Civil Unrest
Cosstal Storm < Delete |
Crop Losses

= < Delete Alll
4] | ©H 1] | +

Figure 6-39: Hazard Type Added

NOTE: For Project Types that require Property Site Inventory (PSI), only the
Hazard Types you select here will be displayed in the Application
Development - Property Site Inventory tab.

15.1f the project type AND the hazard type combination require sea level rise
information, the Sea Level Rise (SLR) sub-tab will appear. If the tab appears,
and the questions are not answered, the project will not be submitted to
Federal Eligibility. Click the Sea Level Rise sub-tab (Figure 6-40).
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NOTE: The questions on the Sea Level Rise tab must be answered for select
project types as indicated by the Admin>Project Type Matrix Information
screen AND the identified hazard types of Coastal Storm, Hurricane,
Severe Storm, Tropical Cyclone, Tsunami, Flood and Typhoon.

Project Type | County Code | Congressional Distrct I Community Names/Codes * | Hazard Type Sea Level Rise |

Are the location of this project and the nature of the project type ..
such that the risk to the project is exacerbated by SLR? Yest Mo

Was SLR considered and included in the mitigation measures
implemented in this project? e O o

Save ! erify | Submit |

Figure 6-40: Mitigation >Projects >Application
Development >Project Info > Sea Level Rise Sub-tab

16.When the project type and hazard selected are applicable to SLR, the SLR
sub-tab will appear. Answer the following questions:

a. Are the location of this project and the nature of the project type
such that the risk to the project is exacerbated by SLR? Select YES
or NO. If YES, user must answer the next question; if not, the next
guestion does not have to be answered.

b. Was SLR considered and included in the mitigation measures
implemented in this project? Select YES or NO.

17. Once the Sea Level Rise questions are answered, Verification or Submitting

the project will require additional data on the Cost Effectiveness tab, as
follows:

a. Was SLR pursuant to 2011-OPPA-0lincluded in the development
of the BCA for this project? Answer YES or NO. If YES, user must
enter a value in green field as follows:

b. Depth in feet of SLR that was added to the flood profiles: enter
value in feet with two decimal places (0.00)

18.0n the bottom left part of the Project Info tab, click the SAVE button.
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Task 5: Enter Work Schedule

1. Click the Work Schedule tab.

2. On the bottom left part of the tab, click the NEW button. A new row for
entering work schedule information is displayed (Figure 6-41).

Maintenance Azsurance | Public Motice | Attachments I Eligibility Rewiew | Froperty Site Inventory | LLatlan | Avthorization |

Applicant Information | Problem & Risk Data | Project Info ~ Work Schedule |C051 Estimate | Match Sources | Cost Effectiveness |

Description

{et] |

TirneFrame

2l |

2

MHew I Delete |

Save | Serify I Subrmit | Amendd | Cloze |

Figure 6-41: Work Schedule - New Row

3. In the Description box, enter a description of the phase in the work schedule.

4. In the Time Frame box, enter the time frame for that phase.
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5. Repeat Steps 2 - 4 for each phase of the work schedule (Figure 6-42).

Mairtenance Assurance | Public Motice: | Attachments I Eligribaility Rewiew: | Property Site Inventory I Lation | Authorization |
Applicant Information | Frokblem & Risk Data | Frojectinfo ~ Work Schedule | Cost Estimate | Match Sources | Cost Effectiveness |
Description TimeFrame

I 1 Complete step 1 manths

I 2 [Complete step 2 marth

| 3 Complete step 3 months|
il il

MNew | Delete |
Save | “erify I Submit | Amend | Cloze

Figure 6-42: Work Schedule - New Items Added

HINT: If you need to re-order the items in the work schedule, highlight and
retype the numbers in the first column of the table. Click another tab (e.g.,
Public Notice) and then click back on the Work Schedule tab. The items in
the table will be re-ordered and automatically saved. Clicking the SAVE
button will NOT reorder the table.

6. On the bottom left part of the Work Schedule tab, click the SAVE button.
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Task 6A: Enter Cost Estimate

1. Click the Cost Estimate tab. A warning message about making changes to
Cost Estimate or Match Sources is displayed (Figure 6-43).

i 2 Mo changes can be mads t the Cost Estimate or Match Saurces screens without completely deleting al Match Sources information and pressing the SAYE buttan,

If & chanige needs to be made on the Cost Estimate screen, the incartect Cost Estimate ine items must be deleted, saved, and re-entered corractly,
After the Cost Estimate information has been corected, re-gnter the Makch Sources information

If Match Sources information is the only screen that needs bo be corrected, delete all Match Sources information completely, press SAVE, re-enter the corect information,
and press SAYE,

The ahove process must also be fllowed when Amendments ate entered t up-date the Cost Estimate and Match Sources information,

Figure 6-43: Warning About Cost Estimate or Match Sources Changes

CAUTION: If you are revising or amending your cost estimate, it is imperative
that the instructions in the above warning be followed. Failure to do
so may prevent project approval, or allocation/obligation.

Individual line items cannot be modified for quantity, unit of measure, or unit
cost. Each line item that is to be revised must be deleted in its entirety
and reentered using the new desired values. Once the Cost Review
portion of a submitted application has been completed and cost
approval is marked as Y it will be necessary to rework the approval
back to the cost reviewer so that they can change the Y to an N to
enable editing of the Cost Estimate screen.

CAUTION: Once the application is approved it will be necessary to amend the
application to revise the Cost Estimate.

2. Click the OK button. The empty Cost Estimate table is displayed (Figure 6-
44).
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Appicert Wiormaton | B ot & Rick Datn | Proect e | | e rincn | amcrmets | Sty e | Propenty Ste ety | | mamrtznten
Totst Project Cost Extmaty o
Hew [ B 1hés pregect part of the Initiatie?  Yes © Mo ©
e R - |
Figure 6-44: Mitigation >Projects > Application
Development >Cost Estimate Tab
3. On the bottom left part of the tab, click the NEW button. A new row for
entering cost items is displayed (Figure 6-45).
Aevicartmicrnmen | Brobien & Risk Datn | Brigect s | et Schmin | == | msresnancn axsrace | P pcticn | anscrmeres | Gty ke | Sroperty stervemtery | | Atrezaton ]
l Rern Name Lrat Oty Unil of Messure Uik Cost Cost Esbmate .
Tow Project CostEsamme [ ®
Now [reinte Is this project paet of tha Inftiative? Yoz T Mo F
Save Merity I Submt | e

Figure 6-45: Cost Estimate - New Row
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4. Enter the information listed in Table 6-4.

Table 6-4: Cost Estimate Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Item Name Descriptive name of cost item
Required Field

Unit Qty Number of units
Required Field

Unit of Measure | Standard measure for each unit

Unit Cost Cost per unit.
Required Field CAUTION: Value must never be $0.

Cost Estimate Cost Estimate = Unit Qty x Unit Cost. Auto-filled by the system
when you press the Enter key after completing the Unit Cost
data field.

Total Project System-generated running total of the Cost Estimate column
Cost Estimate

5. Repeat Steps 3-4 for each cost item you need to add.

6. Figure 6-46 shows Cost Estimate rows added to the project.

Ayt ety | Protien 8 T Dotn | Proest | ek Sctede | Gt Botiemete | tun Saces | Coot Elteirermss | Momdoomn Absamn | Pt e | Allmrmmmrts | Coptoly Rerivor | Priwety Sie virsetir pr—
1 o e Adkrive Codk T e Ak iabedt e i are S6gadee o asiroved prifecta
......... . wioy  unnuressein Cost Esimate
[Froperty mprasain T | E |
|comntee |/ | T |
¥ et Cot babmate 32,500

bew | [ Gawe ] 15 I project part of the initiatve? Yes © Mo &

e | | wew | siew | | e |

Figure 6-46: Cost Estimate Information Added

7. Answer the question, “Is this project part of the Initiative?” by clicking inside
the Yes or No radio button.

8. On the bottom left part of the Cost Estimate tab, click the SAVE button.

9. After saving Cost Estimate information, you may edit the information by
completing Steps 9a - 9d.
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CAUTION: Steps 9a - 9d are needed to ensure that the old Cost Estimate

information is deleted from the NEMIS database and that the new
information is saved. The steps assume that no entries in the Match
Sources tab have been saved. If Match Sources information has been
saved, complete Task 7, Step 7 a-e.

It may not be possible to edit the Cost Estimate if the application has been

submitted for FEMA approval. If the application has passed the Cost
Review step in the Eligibility Determination process and the Y option has
been selected for Cost Approval the Cost Estimate can no longer be edited
unless reworked. Once the application has been approved, it will be
necessary to amend the project and update the Cost Estimate tab by
deleting the Match Sources information, saving, and then deleting the
Cost Estimate line items in need of revision and reentering the line item
as part of the amendment process.

Delete all Cost Estimate line items.
On the bottom left part of the Cost Estimate tab, click the SAVE button.
Re-enter the new Cost Estimate information.

On the bottom left part of the tab, click the SAVE button.
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Task 6B: Import Cost Estimate from the Approved Spreadsheet

The cost estimate can be developed in a pre-approved spreadsheet template and then
imported into an HMGP application that is under development or review.

For the import capability to work, the user must download the HMA-approved Cost
Estimate Import Spreadsheet template. The template can be found on the HMA
SharePoint site at
https://intranet.fema.net/org/fima/collab/RRD/GIB/HMA/Pages/default.aspx. The approved
spreadsheet has pull-down menus and validations built in that NEMIS HMGP uses for
the import to be successful.

CAUTION: User-designed spreadsheets will not work with NEMIS HMGP. Make
sure you use the HMA-approved spreadsheet found at
https://intranet.fema.net/org/fima/collab/RRD/GIB/HMA/
Pages/default.aspx, or contact your NEMIS HMGP regional POC for a
copy of the approved spreadsheet template.

The spreadsheet validations include:

e Whole Numbers — The user must enter whole numbers ONLY, between the
values of 1 and 999,999,999. Attempting otherwise will result in the following
Cost Estimate message:

Cost Estimake

@ Please enter whale number bebween 1 and 999,999,999

Cancel | Help |

Figure 6-47: Cost Estimate Whole Number Warning Message

e Pull-down menu — The approved spreadsheet includes a pull-down menu to
select the unit of measure. The units of measure in the pull-down menu track
directly to NEMIS HMGP. Any attempt to enter a value other than a selection
from the pull-down menu will result in the following message:

Microsoft Excel | x|
@ The walue you entered is nok valid,
& user has restricked values that can be entered inka this cell.

Zancel | Help |

Figure 6-48: Invalid Entry Warning Message
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After filling out the spreadsheet completely and accurately, the process to import the
spreadsheet into the Cost Estimate tab is as follows:

1. Click the Cost Estimate tab. A warning message about making changes to
Cost Estimate or Match Sources is displayed. Read the message and select
OK. The Cost Estimate tab will appear.

2. Select the IMPORT button. The Select File window will appear (Figure 6-49).
Navigate to the folder where the spreadsheet is located, highlight the
completed cost estimate spreadsheet file, and click Open.

%HMGP APPFLICATION: DISASTER #: 9047 FEMA PROJ &: - APPLICATION ID: 99999 AR

Applicart Information | Problem & Risk Data | Project Info | work Schedule | Cost Estimate
Do not inciuce Administrative Cost. These are caiculated when funds are obligated for apn

Iten

Select File

Look jr: I@ Desktop -

DM';.-' Documents

J My Cormpuber

3 [y Metwork Places

I aV3IMRLZ

JCDst_Estimate_Template.xls
Shorkcuk ko ESARREMN

File name: ITest Cozt_Eztimate_Template. =z Open I
Files of ype: | Excel Files [“L5) -| Cancel |
2
Impart I Hew I Delete I
Save I wWerity I Submit I

Figure 6-49: Select File Window

3. If the import is successful, the following Cost Estimate message will be
displayed:

Cost Estinake E

[
. lr) Import completed successfully, Tokal number of reports imporked 5.
"'-.-_-

Figure 6-50: Import Completed Successfully Message
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4. The NEMIS HMGP Cost Estimate will now show the spreadsheet
information entered into the NEMIS HMGP Cost Estimate table (Figure 6-

51).
'\!H"ﬂ' APPLICATION: DISASTER & 9047 FEMAPRODE: - APPLICATIONID: 99333 AMENDMENT #0
Aogiatniomsion | PotkendRikss | Poatiie | o Screse ?Mmélmamm | cosecteness |tz asswce | Paicicice | et | BtReien | Procety Steientoy | 0 | aorzsin |
Do not include Aaminisrative Cost These are cakulaied when funds are obligated v anoroved projects.
[t Mama Unit Gy Unit of Measure Unit Cast CosiEzfimata
- | _I @
Construction Coste: 1S hd
Cemert 400 (¥ - $2 §1,200
Lumber 200 [T Z $124 $24,00
Tore— 1 [oav - §25,00 $35000
Figure 6-51: Cost Estimate Tab with Imported Values
5. All rows on the spreadsheet that are partially completed or incomplete will
be imported exactly as they were entered on the spreadsheet. Blank text
for Item Name and Unit of Measure will be blank after the import and
numerical items such as Unit Qty or Unit Cost will be imported as a 0
(zero). These blank entries will be validated by the system during
verification or submittal as is the process now.
6. Items that contain a zero will be included in the total project cost estimate
and may impact the total amount approved for the project or the Match
Sources tab.
Applicant information | Problem & Risk Data | Projectinfo | Work Schesule | Cost Estimate  Mateh Sources | Cost Effectivencss
Total Project Cost Estimate: | $3,000,1565,007 Proposed Federal Share: | 32,250,117 ,005
Fadaral Share Percentage: | 75 % Proposed Mon-Federal Share: | 750,033,002
Hon-Faderal Funding 1 of1
Source Agency [L,u-:uj :j Furds Availabiity Date : [ 1A 2205
Sources Marme fcush Fursds Commitment Letter Date : | 0102205
Fumnding Ty : [Gﬂﬂh j

Other Fursding
Type Deascriplion : |

% ot
e Mame Linift Gy Uit of Measure Uinit Cost Total Cost Mor.-Fed

[Frushie Cash 1[Ls ;” 5m02&m2-| $500,026,002 | 67%

i Mor Fedshare amount is invalid,
-_f) Pleasse refer ko the Match Sources tab.

Figure 6-52: Verify Message — Non Fedshare amount is invalid.
Please refer to the Match Sources tab
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Task 7: Enter Match Sources Funds

NOTE: Be sure to enter information in the Cost Estimate tab before entering
information in the Match Sources tab.

1. Click the Match Sources tab. A warning message about making changes to
Cost Estimate or Match Sources is displayed (Figure 6-53).
Warning!

Mo changes can be made to the Cost Estimate or Makch Sources screens without completely deleting all Match
Sources information and pressing the SAYE button,

If a change needs to be made on the Cost Estimate screen, the incorrect Cost Estimate line items must be deleted,
saved, and re-entered carrectly,

After the Cost Estimate information has been cotrected, re-enter the Match Sources information

If Match Sources information is the only screen that needs to be corrected, delete all Match Sources information
completely, press SAVE, re-enter the correct information, and press SAVE,

The above process must also be Followed when Amendments are entered to up-date the Cost Estimate and Match
Sources information.

Figure 6-53: Warning About Cost Estimate or Match Sources Changes

2. Click the OK Button. The Match Sources tab is displayed (Figure 6-54).

P i 00k Ootn | otk | o Scomae | Con Gt Ml Sumoen | Cot Ftactvenist | Maresrwce Absracn | i enca | ety | gty | gty Sty | | susteranion
Tatal P w0 Proposed Feder Share: 125
Fdortd Share Prscirtons: | 7 - Propeosd N Fisckon il S TE

Won-Fesseral Funding .

Gron ot Cost 0w
Fehisence Cot Codss
= P ) M8 Do |
S ity Skt Choan

Figure 6-54: Mitigation >Projects >Application
Development >Match Sources Tab

3. The top part of the Match Sources tab displays information described in
Table 6-5.
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Table 6-5: Data Fields in Top Part of Match Sources Tab

DATA FIELD DESCRIPTION

Total Project Cost
Estimate

Dollar amount of the total cost estimate of the project. Auto-filled
by the system with the same value found in the Cost Estimate
tab - Total Project Cost Estimate field.

Federal Share
Percentage

Required Field

Percentage of the Total Project Cost Estimate that will be
federally funded. The default percentage displayed is 75 percent.
Edit the percentage if necessary.

Proposed Federal
Share

Proposed Federal Share = Total Project Cost Estimate x Federal
Share Percentage. Auto-calculated by the system.

Proposed Non-
Federal Share

Proposed Non-Federal Share = Total Project Cost Estimate -
Proposed Federal Share. Auto-calculated by the system.

4. The lower part of the Match Sources tab is the Non-Federal Funding section,
which is designed to display Non-Federal Funding sources for this project. To
add a Non-Federal Funding source, complete Steps 4a - 4c.

a. On the bottom left part of the screen, click the NEW button. A set of
data fields for entering information about a Non-Federal funding source
is displayed (Figure 6-55).

————
Tokst Proecd Ct Estimate | [

——
Federal Share Pevcectage | ™
o deder sl Funding

Source Agency ﬂ

Mckwtrionien | Poe aRaDes | Potni | ekschense | ContEsteate

*

E | Pk totce | amcteats | Dgbdty Bevew | Procefy Stenvetery | | mutmerzseen

Prcparird Frckrsl Shean win
Fropurian i Faceral Stare e

[ree——

Furds Commémant Latter Dt | | 00000000

teew Delte |

G Tt ot n| o

Relrserce Cont Cades

Yo Dinglay

B | e Sumt

|| |

Figure 6-55: Non-Federal Funding Source Data Fields
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b. On the bottom right part of the Match Sources tab, select the Public
Assistance (PA) or the Human Services (HS) Reference Cost Code
List that you will need as a reference. Click the DISPLAY button to
display the reference list.

c. To complete the data fields for each Non-Federal funding source, enter
the information listed in Table 6-6.

Table 6-6: Non-Federal Funding Source Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Source Agency Category of the agency that will provide the non-Federal funds.
Select one of the following:

e Local

e Other

e Private Non-Profit

e State
Source Name Name of the agency that will provide the non-Federal funds
Funding Type Type of funding that will be provided by the source. Select one

of the following:

Administration

Cash

Consulting Fees
Engineering Fees
Equipment Operation/Rental
Labor

Other

Program Income

Supplies

Other Funding Type If "Other" is selected for Funding Type, enter the description.
Description

Funds Availability Date the non-Federal funds will be available.

Date NOTE: This date must always be entered for any project to

Required field indicate that the matching non-Federal funds are available
before FEMA approves the project. No project should be
obligated without this entry and the accompanying
documentation in the project file.

Funds Commitment Date the funds will be committed

Letter Date NOTE: This date must always be entered for any project to

Required field indicate that the matching non-Federal funds are
committed before FEMA approves the project. No project
should be obligated without this entry and the
accompanying documentation in the project file.
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DATA FIELD INFORMATION TO BE ENTERED

I[tem Name Descriptive name of item to be used for non federal share.
Unit Qty Number of units

Unit of Measure Standard measure for each unit

Unit Cost Cost per unit

CAUTION: Value must never be $0.

Total Cost Total Cost = Unit Qty x Unit Cost. Auto-calculated by the
system when you press the Enter key after completing the Unit
Cost data field.

percent of Non-Fed percent of Non-Fed = Total Cost/Proposed Non-Federal Share
Percentage. Auto-calculated by the system.

d. For each additional source of non-Federal funding, repeat steps 4a - 4c.

5. Figure 6-56 shows two Non-Federal funding sources that were added to the
Match Sources tab.

I
Applicant Information | Problem & Risk Data | Project Info | Wiork Schedule | Cost Estimate Match Sources |Cos‘t Etffectiveness | Maintenance Assurance Py

Total Projsct Cost Estimate: ] Proposed Federal Share: 4,125
Federal Share Percertage: IT % Proposed hon-Federal Share: IWT
Hon-Federal Funding 10f 2
Source Sgency : ILnDaI j Funds Availability Date : I 081572011
Source Mame : Fn‘f of Anre Funds Commitment Letter Date : IW
Funding Type : l_

Other Funding
Type Description : I

% of
ltem Mame: Unit Gty Unit of Measure Unit Cost Total Cost Mon-Fed
Fll\f' funds to cover eligiblz expenses. I 1|LS j I 1000 I 1,000 | 73%
Source Bgency ILDcaI j Funds Availability Date I :JE.H 12011
Source Hame : IAdamS Courty Funds Commitment Letter Date: | 03/01/2011
Funding Type : IAdmnlstramn -
Other Funding
Type Description : I
; ’ ; % of
ftem Mame Unit Gy Unit of Measure Unit Cost Total Cost Mon-Fed
Flaﬁ time to complete administrative work 25 [HR: d | 15 3375 | 27%

Figure 6-56: Match Sources Tab with Two Non-Federal Funding Sources
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NOTE: The Total Cost dollar amounts under each funding source are added up.

The sum dollar amount is displayed in the read-only Grand Total Cost
data field on the bottom right part of the Match Sources tab. The
percent’s of Non-Fed under each funding source are also added up. The
sum percentage is displayed next to the Grand Total Cost.

CAUTION: When all the non-Federal funding information has been entered, the

Grand Total Cost dollar amount must match the Proposed Non-
Federal Share dollar amount displayed on the top part of the Match
Sources tab.

6. On the bottom left part of the Match Sources tab, click the SAVE button.

7. After saving Match Sources information, you may edit the information by
completing Steps 7a - 7k.

CAUTION: Steps 7a - 7k are needed to ensure that the old Match Sources

information is deleted from the NEMIS database and that the new
information is saved.

a. Select an item by clicking inside any of the Non-Federal Funding fields.
On the bottom left part of the tab, click the DELETE button.

b. Repeat Step 2 for additional items that you wish to delete.
c. On the bottom left part of the tab, click the SAVE button.
d. Click the Cost Estimate tab and delete all line items.

e. On the bottom left part of the tab, click the SAVE button.

f. Still in the Cost Estimate tab, select the NEW button and re-enter the
new Cost Estimate line items.

g. On the bottom left part of the tab, click the SAVE button.
h. Click the Match Sources tab.

i. Click the NEW button and enter the new Non-Federal Funding item
information.

]. Repeat Step 8i for each new Non-Federal Funding item.

k. On the bottom left part of the tab, click the SAVE button.
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Task 8: Enter Cost Effectiveness Information

1. Click the Cost Effectiveness tab (Figure 6-57).

NOTE: The warning message in red is a reminder that Cost-Effectiveness
information is required even for exempt projects.

Property Ste Inventory | | Authaorization |
Applicant Informetion | Problem & Risk Data | Project Info | Wiork Schedule | CostEstimate | Match Sources  Cost Effectiveness |Ma\rﬁenance Assurance | Public Notice: | Attachments | Eligikility Resiew
All Projects Require Cost Effectiveness Data

Net Present Walue Total Project  Benefit-Cost
of Project Benefits Cost Estimate Reatio Pre-calculsted
(&) (B) (A7B)  Analysis Type Exempt Type Revigwer's Name BCA Performed By Analysis Date Beneft  Comments

Figure 6-57: Mitigation >Projects >Application Development
>Cost Effectiveness Tab

2. On the bottom left part of the Cost Effectiveness tab, click the NEW button. A
new row for adding cost Effectiveness information is displayed (Figure 6-58).

Applicant Information | Prohlem & Risk Data | Praject Info | Work Schedule | Cost Estimate | Match Sources  Cost Effectiveness |Mairrtenance AU

All Projects Require Cost Effectiveness Data

Met Prezert Yalue Total Project  Benefit-Cost
of Project Benefits Cost Estimate Ratio
(&) (A 0B)  Analysis Type Exempt Type Revieveer's Name BCA Performed By

2.000]| Flood | | kG |

Figure 6-58: Cost Effectiveness Data Fields - Left Side

3. Scroll the horizontal bar to the right to view the right-hand part of the new row
(Figure 6-59).

stch Sources  Cost Effectiveness |Maintenance Assurance | Public Fotice | AMtachments | Eligihility Review |

Pre-calculated
Reviewer's Mame BCA Performed By Analysis Date Beneft  Commerts

FEMA, [ || 01230013 Click

Figure 6-59: Cost Effectiveness - Right Side

4. Enter the information listed in Table 6-7.
Table 6-7: Cost Effectiveness Data Fields

Amend # Auto-filled by the system
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DATA FIELD ‘ INFORMATION TO BE ENTERED

Community Community name where project is located. Select from the
places available in the drop-down list.

HINT: If there are no places listed in the drop-down
list, click the Project Info tab. Add Community
Names/Codes by completing Task 4 - Step 12: Add
Community Names/Codes.

Net Present Value of Project Benefits dollar amount as obtained from the
Project Benefits (A) Benefit-Cost Analysis (BCA) documentation

Total Project Cost Project Cost dollar amount as obtained from the Benefit-
Estimate (B) Cost Analysis documentation

Benefit-Cost Ratio (A/B) | Benefit-Cost Ratio = Net Present Value of Project Benefits/
Total Project Cost Estimate. Auto-calculated by the system.

Analysis Type Type of BCA. Select one of the following:

Flood

Wildfire

DFA

Tornado
Hurricane Wind
Upper Bound
Lower Bound
Best Data

Not Applicable
Exempt
Seismic
Hurricane Shelter

Exempt Type Type of exemption if the selected Analysis Type is
"Exempt." Select one of the following:

o Initiative Projects (5 percent and 10 percent)
e Other
e Plans (7 percent)
e Substantially Damaged Acquisition
e State Management Costs
Reviewer's Name Name of person who reviewed the BCA
BCA Performed By Organization of the reviewer. Select one of the following:
e FEMA
e State

e Contractor

Analysis Date Date the BCA was conducted
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DATA FIELD ‘ INFORMATION TO BE ENTERED

Pre-calculated Benefit Identify and verify if pre-calculated benefits were included.
Select one or more of the following:
e None
e Environmental
e 100 YR FP Acquisition
e 100 YR FP Elevation
e Pre-determined
Comments Comments or notes about the BCA

5. Figures 6-60 shows the Cost Effectiveness tab with completed information.

Property Site Invertory | | A thorization |
Applicant Information | Problem & Risk Data | Project Info | Wyork Scheciule | Cost Estimate | Match Sources Cost Effectiveness |Ma\rvtenance ASIUFENCE | Public Mtice | Aftachmerts | Eligibilty Review |
All Projects Require Cost Effectiveness Data

Met Present Yalug Total Proiect  Benefit-Cost
of Project Benefits Cost Estimate Ratio Pre-calculated
(4 (B8) (& 08)  Anslysis Type Exempt Type Reviewer's Name BCA Performed By Analysis Date Benetft Commerts

51 000) 2.000][Fiood o 230013 _

Select Pre-Calculated Benefit

Mane

Environmental

100 ¥R FP Acquisition

100 ¥R FP Elevation

Pre-determined

4| | »

4| I}

Add | Delete | Save | Close: |
Al 1]
New Delete Eenefit Cost Web Page
Save | Wity | Submit I Atment Cloze

Figure 6-60: Cost Effectiveness Data Fields Completed Showing Pre-
calculated Benefit field

6. The Cost Effectiveness tab must be completed and saved before the pre-
calculated benefit function can be used. An entry under Pre-Calculated
Benefit is required for the application to be submitted.

7. Either select None and save and close the dropdown box or select the type(s)
of Pre-Calculated benefits used in the BCA and save and close the dropdown
box.

8. On the bottom left part of the Cost Effectiveness tab, click the SAVE button.

NOTE: BCA documentation is attached to the project using the Attachments tab.
Complete the steps in Task 11: Attach Documents.
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Task 9: Attach Maintenance Assurance Information

CAUTION: Attachments cannot be deleted once they have been added to NEMIS

HMGP. Please make every effort to limit the file attachment size to less
than 1 GB.

1. Click the Maintenance Assurance tab (Figure 6-61).

Apphcond intemation | Probies. & Risk Data |mwsmn |wmmnn-. Coat Extimate:

Coot Btfectveress | | ity Gk |
Hemndes: Mantenance of completed HMGI Propects is not an ehgible grant cost. Apphcants should sdentity &
party to ensure the propect will be maintsined in an elfechive condion corresponding o the grant.

Has the applicant identified any maimenance required to prezerve the long-lem mitigation
cifectivencas of the project?

Please sttacl h maintenance schedule, estimated costs, and identified entity responsible for

Chose

Figure 6-61: Mitigation >Projects >Application Development >
Maintenance Assurance Tab

2. Click the ATTACH/SCAN DOCUMENTS button. The Attach/Scan Document

dialog box is displayed (Figure 6-62). Notice that the Document Type defaults
to "MAINTENANCE ASSURANCE."

]

[~ Scan a Docurment [v Attach a DezkTop Docurent

Dizaster Mumber; I 7319 Application I B Froject Amendment Mumbet: I 1]

Document Type: |MAINTENANCE ASSURAMCE ﬂ

Document Mame: NAINTENANCE ASSURAMNCE

Archive | Cancel

Figure 6-62: Attach/Scan Documents Dialog Box

You are strongly urged to read and follow the instructions in Appendix A:
Attach/Scan Documents.

On the bottom left part of the Maintenance Assurance tab, click the SAVE
button.
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Task 10: Enter Public Notice Information

1. Click the Public Notice tab. The default answer to the question about the
Project Applicant being required to provide Public Notice of the project is "No"
(Figure 6-63).

Property Site Invertory | |Aumunza\mn |
Applicant Information |Prob\em&R\sk Deta |ijec1 Info |Work Schedule | CostEstimate | Match Sources | Cost Effectiveness i Assurance | Public Hotice | Eligilty Review |

Are you required to provice Public Notice of this Project 7 ves (' Na (@

It ¥es piease provide the following information

New Delete
se | veiy | st | e Close

Figure 6-63: Mitigation >Projects >Application
Development >Public Notice Tab

2. If the project requires a Public Notice, click inside the Yes radio button. The
NEW button on the bottom left part of the tab becomes available.

3. Click the NEW button. The Public Notice data fields are displayed (Figure 6-
64).

APPLICATION ID: 5 AMENDMENT #: 0

Project Infa | Work Schedule | CostEstimate | Match Sources | Cost Effectiveness Maintenance Assurance  Public Notice | Attachments | Eligibility Review |

Are you required to provids Public Matice of this Project 7 Yes(® Mo O

If Yes please provide the following information :

Appearance Date: | pOMDOO00

Document of Record

Pairt of Cortact

Telephone Number ; | () - Exin

sove | werity | st | Amend Close

Figure 6-64: Public Notice Data Fields

4. Enter the information listed in Table 6-8.
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Table 6-8: Public Notice Data Fields

DATA FIELD ‘ INFORMATION TO BE ENTERED

Appearance Date Date the Public Notice was posted
Document of Record Name of publication that printed the notice
Point of Contact Name of the contact person in the publication
Telephone Number Telephone number of the contact person

5. For each Public Notice you wish to add, repeat Steps 3 and 4.

6. On the bottom left part of the Public Notice tab, click the SAVE button.
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Task 11: Attach Documents

CAUTION: Attachments cannot be deleted once they have been added to NEMIS

HMGP. Please make every effort to limit the file attachment size to less
than 1 GB.

NOTE: The user must have access to the V drive where the ViewStar operational
files are maintained. The V drive must be active or opened. For additional
ViewStar information, please see Appendix A of the User Manual.

1. Click the Attachments tab (Figure 6-65).

{RIPAGP APPLICATION: DISASTER &: 7519 ITMA PROD # - APPLICATION ID: 5 AMENDMINT £: 0

vpe v |
Agphadnformation | Problem £ Rick Dats | Proectinfa | Wark Schedude | Cout Bstimale | cont |

Availabin Doenmers

onta | Sty Revew |

Btschfcen loouments | View |
Fare Yewify bk | 1 Chos

Figure 6-65: Mitigation >Projects>
Application Development >Attachments Tab

2. On the right side of the Attachments tab, click the ATTACH/SCAN
DOCUMENTS button. The Attach/Scan Document dialog box is displayed.

3. On the Document Type data field, click the drop-down arrow to display the
different document types (Figure 6-66). Select the correct type.

[ [X]

[~ Scan a Docurment ¥ Attach a DeskTop Document

Disaster Mumber: I 7518 Application d: I 5 Project Amendment Mumber: I u]

Dacument Type:

ppeal =
BenefitCost Analysis

Calculation

Contract b

Drawing WLI Cancel |

Figure 6-66: Attach/Scan Documents Dialog Box

Document Mame:
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4. You are strongly urged to read and follow the instructions in Appendix A:
Attach/Scan Documents.

5. On the bottom left part of the Attachments tab, click the SAVE button.
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Task 12: Enter Eligibility Review Information

1. Click the Eligibility Review tab. Seven sub-tabs are displayed, of which only
five are available for entering Eligibility Review information. The Overview
sub-tab is displayed by default. (Figure 6-67).

“HJ'N“ ICATION: DISASTHR & F515 FEMA PROD & APPLICATION ID: 5 AMENDMENT &= 0
Property Ste knertory | | Avthorzatin |

Appcartiomation | Probken FiskData | Proectinfo | WerkSchede | CoEdinate | MatchSources | CotEffectiveness | Manteownce Assursnce | Publotitice | ttachrmerts [ Eplbliny Review |
Overview | Gura Commerts | Cos Commerts | Erormsrtal otz | B Checkiet | FEMALswe/EDs | FEMANERR, |

Cligibility Determination Criterta o ﬂ
Aicint =l Flace Code Pace Name

R | ATS80  Missiesop Chocka inden Ressrvalio
: 00 Avama (Courty)
Project Crteria : = (Courty)
Uthver Renaewis. 90005 Amds (Courly)
| | ot Eitecvenss Reverer 40007 Amala (Courty)
[ =] oo Comglance Review 99708 Bankn (Ooumty)

I =] Miligstion Pian Corformarce
Reecommended tor Apgenvad 2 [ =]
Project Rrdewer (inst, first mike) Revarw Dote ©

Sve Wity Fubmi Ciyge

Figure 6-67: Mitigation >Projects >Application Development
>Eligibility Review >Overview Sub-tab

2. In the Eligibility Determination Criteria section, enter the information listed in
Table 6-9.

Table 6-9: Eligibility Determination Criteria Section Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Applicant Does the Project Applicant meet the Applicant Criteria in 44 CFR
Required field 206.434(a)? Select one of the following:

o Y (Yes)

o P (Pending)

e N (No)

Refer to the Grantee checklist, if applicable.

Project Type Does the project meet the Project Type criteria in 44 CFR
Required field 206.434(c)? Select one of the following:

o Y (Yes)

¢ N (No)

Refer to the Grantee checklist, if applicable.

Project Criteria Does the project meet the Project criteria in 44 CFR 206.434(b)?
Required field Select one of the following:

o Y (Yes)
e P (Pending)
e N (No)
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3. In the Other Reviews section, enter the information listed in Table 6-10.

Table 6-10: Other Reviews Section Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Cost Is the Cost Effectiveness Review complete? Select one of the
Effectiveness following:
Review . Y (Yes)
Required field e N (No)
Code Compliance | Has the Project Applicant filed Code Compliance and Permit
Review Granted documents? Select one of the following:
Required field e Y (Yes)

e N (No)
Mitigation Plan Has the Project Applicant documented the part of the Multihazard
Conformance Mitigation Plan with which the project conforms? Select one of the
Required field following:

o Y (Yes)

o N (No)

Project Reviewer | Name of Grantee Mitigation Staff member who reviewed the
application for eligibility considerations. It may be the same as the

Required field name of the preparer.

Recommended Do you recommend this project for approval? Select one of the
for Approval? following:
Required field e Y (Yes)
e N (No)
Review Date Auto-filled with the current date once the Project Reviewer field is
completed.

4. Click the General Comments sub-tab (Figure 6-68). To enter General
Comments, complete Steps 3a - 3c.

Page 6-56 NEMIS HMGP User Manual MR 3.18.02



December 2015 Unit 6: Manage the HMGP Project Application

g PACE APPLICATEOR: DISASTIR #: 15

FrmEreTm—— P

Appacant niormetion | Protiem 8 Ak Dutn | Projectinde | Vierk Schectde | ComEstmate | Mateh Soueces
Gverver  Garsal Comments | Coxt Comments | Evionmentl Comments

CostEtfectieness | Mantenance Assurance | Pushe otice

Atchmarts | EvgibiRy Rewiow |
| ErwCheckist | MEMA L0 | FEMAREPA |
Commant Ammendment

Data £ Tiema Usar Number  Commants

Mew Dt

Figure 6-68: Mitigation >Projects >Application Development
> Eligibility Review >General Comments Sub-tab

a. On the bottom left part of the General Comments sub-tab, click the
NEW button. A new row is displayed with the Comment Date/Time,
User and Amendment Number fields already filled in by the system

@ HMGP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATIONID: 5 AMENDMENT #: 0 [_[o]x]
Property Ste vertory | | authanzaen |

Applicant Information | Problem & Risk Data | Project Info | Wiork Schedule | Cost Estimate | Match Sources | Cost Effectiveness | Meintenance Assurance

Overview  General Comments |Eust Comments I Environmental Comments
Comment Armendrment
i User Number  Comments
5:01:4EGARREN [

| Pusiichitice | atachimerts  Etgibility Review |
| EnvChecklist | FEMA Laws/EDs | FEMANERS |

Figure 6-69: General Comments Sub-tab with New Row

b. Double click inside the Comments field. The Comment Editor is
displayed.

c. Enter your comments and click the OK button. The comments you

entered are displayed on the General Comments sub-tab (Figure 6-
70).
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G HMGP APPLICATION: DISASTER #: 7519 FEMAPROD] #: - APPLICATIONID: 5 AMENDMENT #: 0

Property Site Invertory |
Applizant Infarmation
vervie

| Aushorizetion

| Problem & Risk Data | Project Info |Wurk Schedule | Cost Estimate | Match Sources | Cost Effectiveness | Mair
w  General Comments |Enst Commerts | Envitonmental Comments

nce Assurance Public Notice | Attachmerts  Efigibility Review
| EnvCheckist | FEMA Laws/EDs | FEMANERS |
Comment Amendment
Date / Time User Number  Comments
@1 19:01:42] EGARREN 0

(Genersl commenis rewarding Eligbity R

New Delete

save | ety |

st |

Amendd Close
Figure 6-70: General Comments Sub-tab with Comments Added

Click the Cost Comments sub-tab (Figure 6-71). To enter Cost Comments,
complete Steps 4a 4c.

@ HMGP APPLICATION: DISASTER #: 7519 FEMA PRO1#: - APPLICATIONID: 5 AMENDMENT #: 0

Property Ste Invertary | | Authorization
Applcart Information | Problem & Risk Data | Project info | Wrk Schedue | Cost Estimata | Metch Sourcss | Cost Effectivensss | Meirtenance assuance | PublicNotica | Atachmerts  Eligibility Review
Oveniew | General Commerts  Cost Comments |Enwnnmenlal Comments | EnvCheekist | FEMA Laws/EDs | FEMANEFA |

Cornment Amendment

Date / Time User Number  Comments

MNew Delete

gae | wenty | gwme |

Amens Close.

Figure 6-71: Mitigation >Projects >Application Development >
Eligibility Review >Cost Comments Sub-tab

a. On the bottom left part of the Cost Comments sub-tab, click the NEW
button. A new row is displayed with the Comment Date/Time, User and
Amendment Number fields already filled in by the system (Figure 6-66).
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| | Autherization |
Applicant Information | Probiem & Risk Data | Project Info |Wnrk Schedule | Cost Estimate | Match Sources | Cost Effectivensss | Misintenance Assurance | Fublic Notice: | Attachments  Eligibility Review |
Overviw | General Comments  Cost Comments |Er\v|ronmer\lal Comments | EnwChecklist | FEMA Lans/EDs | FEMANERS |

Comment Amendment

Number  Comments

New Delete

save | ety | gwmt | fmend Close

Figure 6-72: Cost Comments Sub-tab with New Row

b. Double-click inside the Comments field. The Comment Editor is displayed.

c. Enter your comments and click the OK button. The comments you entered
are displayed on the Cost Comments sub-tab (Figure 6-73).

%HMEP APPLICATION: DISASTER #: 7519 FEMAPROJ #: - APPLICATIONID: 5 AMENDMENT #: 0

Property Site Inventory | | Avtharization |
Applicant Informatian | Problem & Risk Data | Project Info | Work Schecule I Cost Estimate | Match Sources | Cost Effectivensss I Maintenance Assurance Public Motice | Attachmerts  Eligibility Review

Overview | General Conments  Cost Comments IEnvimnmEnla\ Comments | EnwChecklit | FEMALaws/EDs | FEMANERA |

Comment Arnendment
Diate / Time Lser Mumber  Comments
090811 19:08:53 EGARREN 1] Cost commerts regarding Eligibility Review-EGARREN-02108:2011 19:10 GMT

New Delete I
gave | verity | Submit | Amend | Close
Figure 6-73: Cost Comments Sub-tab with Comments Added

NEMIS HMGP User Manual MR 3.18.02 Page 6-59



Unit 6: Manage the HMGP Project Application December 2015

6. Click the Environmental Comments sub-tab (Figure 6-74). To enter
Environmental Comments, complete Steps 5a - 5c.

T,
“HMEP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATION ID: 5 AMENDMENT #: 0 !EE
Property Ste Invertory | | Authorization |
Applicant Information | Problem & Risk Data | Project Info |Wurk Schedule | Cost Estimate | Match Sources | Cost Effect | Maintenance | Public Hatice | Attachmerts  Eligibility Review
Overview | General Comments | Cost Commerts  Environmental Comments |Env Checkist | FEMA Laws/EDs | FEMANERA |
Cornment Amendment
Date / Time User Number  Comments
New Delete
=Ty | Verity | Submit | Amend Close

Figure 6-74: Mitigation >Projects >Application Development >
Eligibility Review >Environmental Comments Sub-tab

a. On the bottom left part of the Environmental Comments sub-tab, click

the NEW button. A new row is displayed with the Comment Date/Time,

User and Amendment Number fields already filled in by the system
(Figure 6-75).

Sﬁle Disaster Projects Funding Plans Repostory  Applications  Admin  Window  Help

Hu@%ﬂc

ChyDisaster ChgGroup  HEMIS E5t

Applicant Information |Prnh\em&R\sk Data |Prnjant Info | Work Schedule |Cnst Estimate |Ma1ch Sources |Cnst Effectivensss |Maimer\snce Assurance

Public Notice | Attachiments Eligibility Review
Overview | General Comments | Cost Comments

Property Site I
Environmental Comments |Er\v Checkist | FEMA Laws/EDs | FEMANERA. |

Comment Amendment
Number  Comments

Figure 6-75: Environmental Comments Sub-tab with New Row

Double click in the Comments field. The Comment Editor is displayed.

Enter your comments and click the OK button. The comments you entered

are now displayed on the Environmental Comments sub-tab (Figure 6-
76).
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Property Ste Invertory | |Aulhunzahun |

Applicant Information | Problem & Risk Data | Froject Info |ka Schedule | Cost Estinate | hstch Sources | Cost Effactivensss | Maintenance Assurance

Public Notice | ttachments Eligit
Dverview | General Comments | Cost Comments

Envirunmenlall:ummenls|Envchaukhst | FEMA Laws/EDs | FEMANERA |

Comment Amendment
User Mumber  Comments

Hew Delete

Save | Verify | Subrit |

Amend Close
Figure 6-76: Environmental Comments Sub-tab with Comments Added

Click the Env Checklist sub-tab (Figure 6-77). To add Environmental
Checklist information, complete Steps 6a - 6e.

“HMEP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATIONID: 5 AMENDMENT #: 0

Froperty Ste nvertory | |Authnnzat\nn |

£ pplicant Informetion | Problem & Risk Deta | Project Info |Wurk Sthedule | Cost Estimate | Watch Saurces | Cost Effectiveness | Maintenarice Assurance

Public Notice Attachments Eligibility Review
Env Checklist | FEMA Laws/EDs | FEMENERA |

Overview | Gereral Comments | Cost Comments | Envirormental Comments

Atternative(s) :
Salect only one altemative
by clicking on the
sppiopriste check box

Mew

Delete

Stele Agency Fed Agency  Documertation
L Corsuitest Consuited Attached

Other lssues

Use Env Comiments' tab to reviews or record additional environmertal informeation

Mew Issue Delete lssue

Save | Verify | Submt |

Amencd Close

Figure 6-77: Mitigation >Projects >Application Development >Eligibility
Review >Env Checklist Sub-tab

a. Click the NEW button. The New Alternative Name dialog box is displayed
(Figure 6-78).

Hew Alernative Name

] Cancel

Figure 6-78: New Alternative Name Dialog Box
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b. Enter a name for the alternative solution. Click the OK button. The
Standard Issues section is displayed (Figure 6-79). This section is a
table that lists the standard environmental and historical issues in

Table 6-11.
State Agency Fed &gency Documentation =
Standard lssues Conztted Conzutted Attached
Iﬁquaticﬂerrestial Eintic Resources |F'resenc:e i area undetermined j F 'v' '7
IDe&ignated Floodplain/Floodway IPresence it area undetermined j F '7 F
IH azardous Materials IF'resenc:e in area undetermined j F '7 '7

=l

Figure 6-79: Standard Environmental and Historical Issues

Table 6-11: Standard Environmental and Historical Issues

ISSUE

Aquatic and Terrestrial
Biotic Resources

EXPLANATION

If the project occurs in an area that has resources designated
as aquatic or terrestrial, the impact must be documented

Designated Floodplain/
Floodway

If the project occurs in an area designated by the NFIP as a
floodplain or floodway, the impact must be documented

Hazardous Materials

If hazardous materials (as designated by EPA’s hazardous
materials regulations) are present at the project site, the
impact of managing the materials must be documented

Historic Structures

If historic structures (as designated by the National Historic
Preservation Act) are present, the impact on those structures
must be documented

Hydrology/ Hydraulics

If the hydrology or hydraulics of the area might be impacted,
the impact must be documented

Land Use/Development
Patterns

If land use or development patterns might be impacted, the
impact must be documented. A document to demonstrate
consultation with the local government should be attached,
following the instructions in Task 11: Attach Documents.

Local Economy/
Community/ Services

If a local economy, community, or services might be affected,
the impact must be documented. A document to demonstrate
consultation with the local government should be attached,
following the instructions in Task 11: Attach Documents.

Low-Income or Minority
Populations

If low-income or minority populations are present, the impact
must be documented

Prime Farmland

If a prime farmland is present, the impact must be
documented

Slopes and Soils

If slopes or special soils are present, the impact must be
documented
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ISSUE EXPLANATION

Special Status Natural | If a natural area is present, the impact must be documented
Areas

Threatened/ If a species designated as threatened or endangered is
Endangered Species present, the impact on the species must be documented

Water Quality Water impacts should be documented to meet the Clean
Water Act requirements

Wetlands If any wetlands are present, the impact must be documented

c. For each Standard Issue in the list, complete the following steps. You
will need to scroll down to display the rest of the Standard issues.

I.  Select the Status of the issue from the drop-down list. Select one of
the following:

e Not in project area
e In project area with no effect
e Presence in area undetermined
e In project area - effect unknown
e Adverse effect
ii. Inthe State Agency Consulted checkbox, click inside if the
appropriate State Agency was consulted.

iii.  Inthe Fed Agency Consulted checkbox, click inside if the appropriate
Federal Agency was consulted.

iv. In the Documentation Attached checkbox, click inside if
documentation about the issues is attached.

d. If additional environmental or historical issues were addressed by this
alternative, click the NEW ISSUE button. A new row under the Other
Issues section is displayed (Figure 6-80).
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“HHGP APPLICATION: DISASTER #: 7519 FEMAPROJ#: - APPLICATIONID: 5 AMENDMENT #:0

Property St Inventory | |Authmzamn |
2pplicant Information |PmmemaRuskData |Pm|em|nfn |WnrkS|:hedule |Cus\Es1\matE |MalchSDumas |CD§IENEC{|\/EnEss |Ma|ntenam:EAssurancE Public Motice | Attachments  Eligibility Review

Dverview | General Comments | Cost Comments | Envionmental Comments E"VEhECHi!l|FEMALawsIEDs | FemanErs |

Alternativets) : ([ ig action
Se‘agiz'a‘gk?::::f{”f”"e i [Acquisition of 10 Homes Adams Ca New
appiopriate check box ([ Detention Basin Delete
State Agency Fed Agency Documentation

Stancard lssues Consutied Consuited Aftached

Presence in area undetemined

Aquatic/Temestial Biotic Resources

Designated Floodplain/Floodway Presence in area undetemined |7
Hazardous Materials Presence in area undetemined j F |7 |7 J
COther Issues

Use 'Env Comments' teb to review of record addtional environmental informeation New lssue Delete lssue

Save Werify | Submit | Amen Close

Figure 6-80: Other Issues Section - New Row

e. For each new issue, complete the following steps.
i.  Enter a short description of the new issue.
ii.  Select the Status of the issue from the drop-down list.

iii.  Inthe State Agency Consulted checkbox, click inside if the
appropriate State Agency was consulted.

iv.  Inthe Fed Agency Consulted checkbox, click inside if the appropriate
Federal Agency was consulted.

V. In the Documentation Attached checkbox, click inside if
documentation about the issues is attached.

8. To add another alternative solution, repeat steps 6a - 6e.

9. After entering three alternative solutions and completing the checklists for
each one, the Alternative Names are displayed in the top part of the Env
Checklist sub-tab (Figure 6-81).
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Q%HHGP APPLICATION: DISASTER #: 7519 FEMAPROJ#: - APPLICATIONID: 5 AMENDMENT #:0

Propetty Ste Inventary | |Authuriza1\on |
Agplcart nformation | Problen & Risk Data | Projectinfo | Werk Schectle | Cost Estinate | Melch Sowrces | CastEffectiveness | Maintenance Assurance | Publc Notice | Atizchmerts  Eligibillty Review

Overvisw | General Comments. | Cost Comments | Environmental Comments E"VEhECHi!l|FEMALawsIEDs | FemanErs |

Aternative(s): [ o Aotion
53&&1}‘;?:;;%”;"‘* [ [Acquisition of 10 Homes Adams Co pen
appiopriate check box [~ [Detention Basin Delzte

State Agancy Fed Agercy  Documertation
SRS Consufed Consuited Aftached

Fresence in area undetemined

hquatic/Terestial Biotic

Designated Floodplain/Floodway Fresence in area undetemined

Hazardous Materials Presence in area undetermined j l.;' F

Other |ssues

Use 'Env Comments' teb to review of record addtional environmental informmeation New lssue Delete lssue
Save | Werify | Submit | Amend Close

Figure 6-81: Env Checklist Sub-tab - Alternatives Section

10. Select the proposed action from the Alternative Names by clicking inside the
checkbox to the left of the Alternative Name.

11.0n the bottom left part of the tab, click the SAVE button.

12.Click the FEMA Laws/EOs sub-tab. Read-only Status and Comments
information are displayed (Figure 6-82).

T L ===
“HMGP APPLICATION: DISASTER #:7519 FEMAPROJ#: - APPLICATIONID: 5 AMENDMENT #: 0 [ (O] x]
Property Site Inventory | | Authorization |

Applicart Information | Problem & Risk Data | Project Info | Witk Scheduls | (st Estimate | Match Sources | Cost Effectivensss | Mairtenance Assurance Public Metice | Attachments  Eligibility Review

Overvigw | General Comments | Cost Comments | Envionmental Comments | EnvChecklst ~ FEMA Laws/EQs | FEMA NEFA |
Laws/FOs Status Comments (4000} -
nilangersd Species Act (ESA) =l View
ish and Wildlife Coordination Act (FACA) ;I Wiew
oastal Zone Management Act (CIMA) LI Wiew
oastal Barriers Resources Act (CERA) ;I View
lean Vater Act (CA) a| View
lational Historic Preservation Act (NHPA) LI View
ean Air Act (CA4) a| View
0. 12858 Enviranmental Justice for Low Income and Minarity Populations LI View
0. 11990, Wetlands = View
=
Conditions Required (4000} Monitoring Monitoring Completed
Law {Double Click to edit the Condition) Entered By Required Date
G0 to Project Mansgemert screen to complete the Conditions after the Environmentsl Review is approved.

é‘avg | Werify | Subrmit | _IAmand _Iclnse

Figure 6-82: Mitigation >Projects >Application Development >Eligibility
Review >FEMA Laws/EOs Sub-tab

13.Click the FEMA NEPA sub-tab. NEPA review information is displayed (Figure
6-83).
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\GRHMGP APPLICATION: DISASTER #: 7519 FEMAPRO] #: - APPLICATIONID: 5 AMENDMENT #:0 o=

Froperty Stte Inventory | | Autharization |
Applicant Information | Prablem & Risk Data | Project Info |Wurk Schedule | Cost Estimate: | Match Sources | Cost Effectivencss | Maintenance Assurance | Public Hatice | Atachmerts  Eligibility Review |
Overview | General Comments | Cost Comments | Envionmental Comments | Env Checklst | FEMA Laws/E0s  FEMA NEPA |

Indicate Level of Review

FEMA Status

| =l Mo NEPA determination: User must select a level of review and stanu.

Conditions Required (4000} Monitoring Monitoring Completed
(Double Click to edit the Condition) Entered By Required Date
0 to Project Mansgement sereen to complete the Condiions after the Emviranmental Review is spproved
Comment:
View

e veiy | swnt | _I’Ame”d _IC'”Se

Figure 6-83: Mitigation >Projects >Application Development >Eligibility
Review >FEMA NEPA Sub-tab
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Task 13A: Enter Property Site Inventory Information

NOTE: If the Property Site Inventory tab is grayed out, it means that the project
type selected on the Project Information tab does not require a Property
Site Inventory (PSI).

1. Click the Property Site Inventory tab (Figure 6-84).

Applicant Information I Proklem & Risk Data | Project Info | Wiork Schedule | Cost Estimate | atch Sources | Cost Effectiveness Maintenance Assurance|

Eligioilty Reviews  Property Site Inventory | | Autharization | Checklist |

Humber of Properties in Prnject:l 25 Add
Hame Damaged Address City State  ZIP |PropertyID Delete

RATELAFF, JERRY 123 NOMAMIE ST RUSSELLYILLE Sort

ARSH, STAM 02 WEST 18 RUSSELLYILLE AR T2801 3

Export
Irmport

Frint

Figure 6-84: Mitigation >Projects >Application Development >Property Site
Inventory Tab

2. Enter the number of properties included in the project in the Number of
Properties in Project field.

NOTE: Unless the matrix indicates the project type is eligible for HMOS
Validation, at closeout the number of properties in the project field entry must
match the number of properties entered in the PSI for which the question “Is
this property included as part of the final project?” is answered YES! (See Unit
12 for additional information.

3. Click the ADD button. The Look up a Property window is displayed
(Figure 6-85).

g’aLuuk up a Property
Enter Criteria: Search |
First Middle Last
Name: | | | Al
Address 1: |
Address 2: | il
City:l State:l | ZIP:l | |
Directions: | LI

LCancel

This information is subject to the Privacy Act of 1974,

Figure 6-85: Look up a Property

4. Enter information in the fields that you have data for.

HINT: Providing more information speeds up the search for the property.

5. Click the Search button. Information for the first property found is displayed.
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6. Scroll down through the search results until you find the property you wish to

select (Figure 6-86).

%Lnnk up a Property

Search Results: 1 of 3 records

Lueny

First Middle Last -

Name: [ [FavRE :I o
Address 1: [4 THROWBACK LANE —
Address 2: Save |

City: [ARNA, State: [MS x| ZIP:[38617 =] |
Directions: | ] ak |

LCancel |

Figure 6-86: Displayed Information of a Found Property

This information is subject to the Privacy Act of 1974,

7. Click the OK button. The selected property information is now displayed on
the Property Site Inventory tab (Figure 6-87).

File Disaster Projects Funding Plans Repository  Applications  Admin  Window  Help

“E © B e [ 3

icaster Chg Group Flanz MERMIS Exit

HMGP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATIONID: 12 AMENDMENT #: 0

Applicant Informetion | Problem & Risk Data | Project Info | Wwiork Schedule | Cost Estimate | Match Sources | Cost Effectiveness | Maintenance Assurance |
Public Notice | Aftachments | Eligibiity Reviews ~ Property Site Inventory |

Humber of Properties in Project: 1 :I

I Avtharization I

Hame Damaged Address City State  ZIP  Prpty ID Add
| [F&+RE, BRETT ACH,

Delete

Print

Owner Info | MT Property Site | Property Info I Flood Zone Designation I MFIF Infa I Hazard Type FIRM Infa I Property Site Funding I Marrative I
Property ID: 1
I= this property included as part of the final project ? lﬁ
Name: BRETT FevRE

Damaged Iﬂ THROWBACK LAME
Address:

Mare Creener Info |

T2 | =G

Co-owenet:
Courty : [&dams =1
Title Holder - Post Mitigation: bRETT FAYRE

MT Property Site - Funds Paid? -1 -

Save | Werify | Submit | Amend | Close |

Figure 6-87: Selected Property Displayed on Property Site Inventory Tab

8. Below the property information, nine sub-tabs are provided for adding
Property Site Inventory information. The Owner Info sub-tab is displayed by
default.

NOTE: Fields in Purple text are required before a project closeout. Fields in Navy
or blue text, are property attributes, which means that they will be
carried over from project to project for a particular property site. If you
update a blue field in one project, the field will be updated in all projects
where this property appears. Fields in Red are both. Fields with a green
background are required at application submission.

9. To add Owner Information, enter the information listed in Table 6-12.

Table 6-12: Owner Information Data Fields
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DATA FIELD INFORMATION TO BE ENTERED

Is this property Is the property included in the final project? Select one of the
included as part of the | following:
final project? e Yes

e No - If Nois selected, no further property
information is required.

Co-owner Name of the person or organization who jointly owns the
property.

County County location of the property. Select from the drop-down
list.

Title Holder — Post Name of the organization, community, or person who will own

Mitigation the title to this property following the mitigation measures.

Required field

MT Property Site — Were funds paid to the owner for the mitigation of the
Funds Paid? property? Select one of the following:
Required Field e Yes

e NoO

10.Click the MT Property Site sub-tab (Figure 6-88). To add MT Property Site
information, complete Steps 10a - 10c.

ﬁHMEP APPLICATION: DISASTER #: 7519 FEMAPROJ#: - APPLICATIONID: 5 AMENDMENT #: 0

Applicant information | Problem & Risk Data | Project Info | ‘Work Schedule | Cost Estimate | Match Sources | Cost Effectiveness Mairtenance Assursnce Public Notice | Attachments | Eligibilty Review |

Property Site Inventory | | Authorization |
ted il
Delete
Frint
Ownerlnfo  MT Property Site | Property Info | Flood Zone Designation | NFIP Info | Hazard Type: | FIRM Infa | Praperty Site: Funding | Maative |
Property 1D: 1
Property Action Property Action PFrimary
Add >
Acyuisttion of Yacant Lanc addl
>

Acguisition/Demolition

AcyuistionRelocation

Elesvation < Delete

Floodproofed < Delate Al

Cther (Specify in Comments)

Sate Roomiind Sheter

Seismic Retrofft

Wilifire Retrofit

Wind Retroft

=l
Save | Werify | Submit | Amend Close

Figure 6-88: Mitigation >Projects >Application Development >
Property Site Inventory >MT Property Site Sub-tab

a. On the left side where the Property Actions are listed, highlight the row(s)
you wish to select.
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b. Click the ADD or ADD ALL (if you highlighted more than one row) button.

The Property Action(s) you selected is (are) now displayed on the right
side (Figure 6-89).

Ele [isoster FProjects Fundng Plons Bepostory  Apphcetions  Admig  Window  Lielp
m ki = 1 3
[ L

GRHMGP APPLICATION: DISASTER #: 7519 FEMA PROD #: - APPLICATION 1D 12 AMENDMENT #: 0
Appicant Informaticn. | Probiem & Risk Data | Projectinfa | Wéork Schedue | Cost Estimate | Maich Sources | CostE Fublic Notice | Aiachmentz |
Evgaary Review  Property Ske ineentory | | Avencezation |

Humbar of Praparties in Proj

Ownerirde  MT Property Site | Property infe | Flood Zone Desianation. | NFIRInGe | Mazaid Tupe | FIBMInke | Propedy Site Fundrg | Namatve
Progity 1D: 1

===l il

Uarmaged Addross
LANE

Propesty Action Priey

=3

Propesty Action

Aads
Accuistion of Vecant Land AcquistionCemcition
5 Add sl s S
Gl

Floadprosted S
b {Spmeity in Commenls) < Dialeta AL
ate Foomaing Shef

swe | yority | gubea | i s

Figure 6-89: Property Action(s) Added

c. Click inside the checkbox to indicate the one primary action. This is a

required field for a Property Site Inventory.

11.Click the Property Info sub-tab (Figure 6-90). To add Property Information,
enter the information listed in Table 6-13.

rojects  Eonding Plans Repository  Applications  Admin Window  Help

H e L3 |
P =)

Eligibility Review

Number of Properties in Project: 7 :I

Hame Damaged Address City State  ZIP  Prpty 1D 2dd
CK LANE s 30617
Delete
Frint
Ownerlrfa | MT Propery Sie  Property Info | Flaod Zore Designation | NFIPInfo | Hazaid Type | FIRM Info | Propery Site Funding Narrative
Property D: 1
Age of Structure (vear buity [ 1999 (e.g., 1982) Ty of Residence: [Owner Cocupied - Principal Residence -

TION: DISASTER #: 7519 FEMA PROJ #: - APPLICATION ID: 12 AMENDMENT #: 0
n | Prosiem aRiskoata | Projectinta | Schedule | Cost Estimate | Match Sources Cost Effectiveness | Meintenance Assurance | Public Notice | attachments |

Property Site Inventory | | Authorization |

Pre-Event Fair Merket Value: [ § Structurs Type: [Sngle Famiy ]
Parcelbumber: | cundation Type: [Basemert <]
Property Tex Id: 525908
Lstitude: [ 31 050000000
Longitude: [ 126300000000
sHPOClearet [ x|

SHPO Cleared Date: | 00/00,0000
Benefit-Cost Analysis Performed: -

Benefi-Cost Ratio: 000

Click for sample latitude and longitude == Sample ... | Post-Migation - Property Use ~ -

on

save | veity | suemt | Amend Close

Figure 6-90: Mitigation >Projects >Application Development >
Property Site Inventory >Property Info Sub-tab

NOTE: Fields in Purple are required before a project closeout. Fields in Navy or

blue, are property attributes, which means that they will be carried over
from project to project for a particular property site. If you update a blue
field in one project, the field will be updated in all projects where this
property appears. Fields in Red are both. Fields with a green background
are required at application submission.

Page 6-70

NEMIS HMGP User Manual MR 3.18.02



December 2015

Unit 6: Manage the HMGP Project Application

Table 6-13: Property Information Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Age of Structure
Required field

Year the structure was built

Pre-Event Fair Market
Value

Dollar amount of the fair market value before the event

Parcel Number
Required field

Parcel identification number

Property Tax Id
Required field

Property tax identification number

Latitude and Longitude
Required field

Latitude and Longitude readings in decimal degrees

HINT: Click the SAMPLE button to see latitude and
longitude entries (Figure 6-82).

SHPO Cleared

Has the State Historic Preservation Officer (SHPO)
approved the property action? Select one of the following:

Yes

No

Not Applicable
Unknown

SHPO Cleared Date

Date that the SHPO approved the action.

Benefit-Cost Analysis
Performed

Has a Benefit-Cost Analysis (BCA) been performed?
Select one of the following:

e Yes,

e No

o Not Applicable
e Unknown

Benefit-Cost Ratio

Ratio resulting from the BCA if a BCA was performed

Type of Residence
Required field

Type of residence. Select one of the following:

Not Applicable

Owner Occupied - Principal Residence
Owner Occupied - Secondary Residence
Rental

Other (specify in comments)
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DATA FIELD INFORMATION TO BE ENTERED

Structure Type Type of structure. Select one of the following:

Required field Single Family

2-4 Family

Multi-Family Dwelling (5 or more units)
Manufactured Home

Non-residential — private
Non-residential — public

Vacant Land

Other (specify in comments)

Foundation Type Type of foundation. Select one of the following:

Required field Basement

Crawl Space

Elevated on Piers, Piles, Posts, Columns
Slab on grade

Vacant Land

Other (specify in comments)

Basement Is the structure a basement? Select one of the following:

Required field e Yes
e No

Base Flood Elevation Computed elevation to which floodwater is anticipated to
rise during the base flood

First Floor Elevation Elevation, in feet, of the property.

HINT: Click the DIAGRAM button to see what is meant
by the first floor (Figure 6-83).

Number of Feet Number of feet the lowest floor elevation of the structure is
being raised above Base Flood Elevation (only applicable
when Property Action is Elevation)

Damage Category Percent of Property Damage. Select one of the following:
e (0-49 percent
e 50-99 percent
e 100 percent
o N/A
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DATA FIELD INFORMATION TO BE ENTERED

Post-Mitigation Property | Proposed property use. Select one of the following:
Use

e Agricultural
While not required e Park
here, it is required e Recreation
before project closeout e Vacant Land
e Wetlands
e Other (specify in comments)

NOTE: Once you enter data in one field on a PSI sub-tab, all fields in green
(required) on that sub-tab must be entered before you can SAVE that data
and move to another sub-tab. Otherwise, you will have to cancel your
changes, and your data will be lost.

a. To see a sample of Latitude and Longitude entries in decimal degrees
(Figure 6-91), click the SAMPLE button.

mLatitude and Longitude E3

Latitude ="+" for Narth and "' for South | Longitude = """ for west and "'+"' for E ast

Drata enty requires a """ entered for each negative entry. A"+ gign iz not reguired before
positive entriez. A sample latitude and longitude iz az follows:

B42 Franklin Street Latitude = 37. 77215

San Franciseo, Califormia = Longitude = -122.43014

The latitude and longitude reflects the location of the main structure on the property.

The latitude and longitude fields within the project application in Application Development section
of HMGP, HMGP-Historical and FMA are decimal degrees.
11 Theze fields will nat accept latitude and longitude values in the form of degrees, minutes, seconds naor will it
autamatically convert them to decimal degrees.
21 Any values that you want to enter in the degrees, minutes, seconds format must be converted to decimal
degrees before entering them.
31 This value may be at the County level (4 digits), athough more accurate values are preferred.
For comments regarding latitude and longitude, please include the following:
11 For projection, indicate Morth American Datum (MADY 83 or Wiorld Geodetic System (WiGS) 54
21 For accuracy, indicate Low, Very Lowy, Moderate or value in Feet or Meters
31'WWhen using street address | exclude PO, boxes and 911 addresses

Frint | Cloze |

Figure 6-91: Latitude and Longitude Sample

b. To see an illustration of First Floor Elevation (Figure 6-92), click the
DIAGRAM button.
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hm Diagram

First floar elewation iz defined as the elevation in feet above sea
lewel of the top of the lowest finizhed floor above grade.

FIRST FLOOR

ME=T HIGHER ELEVATION

GRADE FLOOR, |~

BOTTOM FLOOR
(BASEMEMT]

___________________________________

Figure 6-92: First Floor Elevation Diagram

12.Click the Flood Zone Designation sub-tab (Figure 6-93). To add Flood Zone
Designation information, complete Steps 11a - 11b.

\@HMGP APPLICATION: DISASTER #: 7519 FEMAPROT#: - APPLICATIONID: 12 AMENDMENT g
Public Notice | Atischments |

#ppicart information | Problem & Fisk Deta | Projectinfo | work Scheckie | Cost Estimate | Metch Sowrces | Cost Eftectiveness | Maintenance Assurance

Eicibiity Review  Property Site Inventory | | Autharization |

Number of Properties in Prnject:l 1

Damaged Address
LANE

City State  ZIP Prpty ID Add

Delete
Print

| Narative |

Hame

OwnerInfo | MT Property Site Property Info Flood Zone Designation | MFIP Info | Hazard Type | FIRM Info | Property Site Funding

Propetty ID: 1

Fliood Zone Desc N Flood Zone Desc
=l Add >

=k)

Area of special fiood hazard where enough Add All

progress has besn made on a protective
system, such as dikes, dams, and levess, 1o

consider it complete for insurance rating J < Delete

purposes

< Delete All

o
Area of special floodd hazard without water

surface elevations determined

4] | _'ILI 4 1B
=l
Emend Close

Save | erify | Subrmit |

Figure 6-93: Mitigation >Projects >Application Development >
Property Site Inventory >Flood Zone Designation Sub-tab

a. On the left side where the Flood Zone Descriptions are listed, highlight the
row(s) you wish to select. If you choose Other, you must specify a

comment.
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b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The Flood Zone Description(s) you selected is (are) now displayed on the
right side (Figure 6-94).

@ HMGP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATION ID: 12 AMENDMENT #:0

Applicant Information | Prokiem & Risk Data | Project Info | Wark Scheduls | Cost Estimate | Match Sources | CostEffectiveness | Maintenance Assurance | Public Notice | Aftachments |

Elighiity Review  Property Site Inventory | | Authorizetion |
Humber of Properties in Project: 1 j
Hame Damaged Address City State  ZIP Prpty 1D Add
Y S G617 1
Delete:
Prink
Ouwner Info | MT Property Site Property Info Flood Zone Designation | NFIP Info | Hazard Type FIRM Infa | Property Site Funding Narrative
Property ID: 1
Flocct Zone Desc Al pgsy | Flood Zone Dese
Cx = | 2130, 86
Area of minimal flood hazards AddAll> | | area of special flood hazard with water surface

elevations determined

< Delete
B % < Delate All

Area of moderate flood hazards

0
Area of moderste mudsiide (i.e., mudfiow)
hazards

4 I» 4] | b
K
Save | Verity | Submit | Amend Close

Figure 6-94: Property Site Inventory - Flood Zone Description Added

13.Click the NFIP Info sub-tab (Figure 6-95).

R 1 IGP APPLICATION: DISASTER #: 7519 FEMA PROD & - APPLICATION ID: 12

Applkcant information | Problem & Risk Gatn | Project inin | Work Schecde | Cost e
Engtasy Revew  Property Site inentony | | Autncrizaton |

?
]
£
H
i

Owrelnde | MT Properdy Side | Prepeilyinte | Flood Zore Desgration HFIP Info | Hazsd Type | FRM info | Propey Site Furdeg | Hansinee
Froperty I0: 1
Flocet Source [Riverine Fiooang =] Structure Located in: [T R— |
dnfirmd an S ——
arnatos 0 it & Doy gue el

Rapstive Loss Strusture: [BD =] € 2.3 insurnel Inzsns cumuisthvoty n bulting fair marksl vaus
Repettive Loss Humber : 000000 23 = basding fnir

Figure 6-95: Mitigation >Projects >Application Development >
Property Site Inventory >NFIP Info Sub-tab

To add National Flood Insurance Program (NFIP) Information, enter the
information listed in Table 6-14.
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Table 6-14: NFIP Information Data Fields

DATA FIELD INFORMATION TO BE ENTERED

Flood Source
Required field

Source of the flood hazard. Select one of the following:

Coastal Basin

Closed Basin

Riverine Flooding

Storm water Runoff
Other (comment required)

Structure Located
In

Geographical location of structure. Select one of the following:

Floodway

Floodplain

Other High Hazard Area
Not Applicable

Repetitive Loss
Structure

Required field

Does this structure experience repetitive loss? Select one of the
following:

e Yes
e No
e Unknown

Repetitive Loss

Also known as property locator number this is a unique 7 digit

Number number assigned by the NFIP to repetitive loss properties
NFIP Policy Flood insurance policy number
Number

Insurance Policy
Provider

Name of flood insurance company

FIRM Available?

Is there a Flood Insurance Rate Map (FIRM) available? Select
one of the following:

e Yes
e No
e Unknown

Is the property site marked on the map? Click inside one of the
following radio buttons:

e Yes, map is attached
¢ No, hard copy of map will be provided in hard copy
e Not applicable

14.Click the Hazard Type sub-tab (Figure 6-96). To add Hazard Type
information, complete the following steps.
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cts  Funding Plans Repository  Applications  Admin Window Help

| Probiem & Risk Data

Property 1D: 1

Hazard Desc

Hazard Desc

Add All >

< Delete
< Delete Al

Applicart Information | Project info | work Schedule | cost Estimste | Match Sources Cost Effectiveness | Meintenance dssurance | PublicNotice | attachments |
Eligibiity Revievs  Property Site Inventory | | Authorization |
Number of Properties in Project: 1 j
Hame Damaged Address city State  ZIP  PrptyID add
FAVRE, BRETT AN
Delete
Print
Dwnerlfo | MT Fropeny Site | PropenyInfa | Flood Zone Designation NFIP Info ~ Hazard Type | FIRM Info | Property Site Funding Narrative

K|

save Werity Sukmit

Amend Close

Figure 6-96: Mitigation >Projects > Application Development >
Property Site Inventory >Hazard Type Sub-tab

NOTE: The left side will display only hazards that were added in the Project Info

tab > Hazard Types sub-tab.

a. On the left side where the Hazard Descriptions are listed, highlight the

row(s) you wish to select.

b. Click the ADD or ADD ALL (if you highlighted more than one row) button.
The Hazard Description(s) you selected is (are) now displayed on the right

side (Figure 6-97).

Fie Dsaster Frolects Funding Plans Reposiiory  Appications  Admin Window Help
H & 8 e [
ChaDirets ChgGrop  Plne  NEMIE  Eair
g HMGP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATION ID: 12 AMENDMENT #: 0
Applcart Information | Problem & Risk Deta | Project Info | wiork Schectule | Cost Estimate | Metch Sources Cost Effectiveness | Maintenance Assurance Public Mot attachmerts |
Eligibility Revisw Property Site Inventory | | Authorization |
Humber of Properties in Project: 1 j
Hame Damaged Address City State  ZIP  Prpty 1D add
FAVRE, BRETT ANE
Delete
Print
Duwrerlnfo | MT Propery Site | PropertyInf | Flood Zone Designation NFIPInfo  Hazard Type | FIRM Info | Property Site Funding Narrative
Froperty ID: 1
Hazard Desc .| [ Hazard Desc
R
Fload
Add Al >
< Delete
< Delete Al
= werify suomt | Armend Close

Figure 6-97: Hazard Description Added
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15.Click the FIRM Info sub-tab (Figure 6-98). To enter Flood Insurance Rate
Map (FIRM) information, complete Steps 14a - 14k.

NOTE: FIRM information is required for Closeout.

e [uraster Projects Lundng Plans Bepository  Applicstions  Admin  Window  [elp

[ 2 H @, m
Cagusaster ChpGroap  Pas  NEMIE e
APPLICATION: DISASTER #: 7519 FEMA PROJ &: - APPLICATION ID: 12 AMENDMENT #: 0
Appicart ntormation. | Problem £ sk Date | Projectinte | wirk Schecule | Cost Estinate | matcn Sources | Cost Efrectiveness Mainterance Assursnce | Pubiic Niotice | anachiments |
Ehgitaly Review A I . | e
Humber of Properties in Project:| 1 Add i’

Hame Damaged Address City state 2| Property | s

OwnesInfo | MT Fropesty Sie | Propeity Info | Flood Zone Designation | MFIP Info | Hazerd Type  FIAM Info Ianr\Hly Site Funding | Mamative
Property I0: 1

Community Information

CommueRy | nst |

L Deiete |

Map Specilic For 5

=
Panel Numbr | ome | Add I

S | Werity | Submit | e Close

Figure 6-98: Mitigation >Projects >Application Development >
Property Site Inventory >FIRM Info Sub-tab

a. In the Community Information section, click the ADD button. A new row for
adding community information is displayed.

b. Click the drop-down button to display the communities available for
selection (Figure 6-99).

Ede [isaster  Projects Fundng  Plans Repository  Applcations  Admin  Window  Help

[=d = = ) m

R HMGP APPLICATION: DISASTER #: 7519 FEMAPROJ #: - APPLICATION ID: 12 AMENDMENT #: 0

Appicart ntormation | Provtem £ sk Date | Projectint | work Schecute | Cost Cstimate | Mstcn Sources | coste Pubic Motice | attactments |
Eigininy Review  Property Site Inventory I ‘o | suanarization |
Humber of Properties in Project:| 1 fudd :I
Harne Dasraged Address City State  ZIP | Property 10} Dokln
=7 206 ot
Expoat.
Imposl
Firi
Owwes Il | M1 Propsly Ste | Fropeily indo | Flood Zone Desgnaton | NFIP ko | Hazed Type  FIRM Info | Propery Ste Funding | Manstive |
Proparty I 1
Community Information
Community | agd |
e Courty * Delele
ity
I
Detetn |

Edlt Panels I

=
gave | weity | suben | prvend_| trsa

Figure 6-99: FIRM Info Sub-tab >Community Information Section
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NOTE:

The communities in the selection list are those that you added in the
Project Information tab > Community Names/Codes sub-tab. If Statewide
was used as the Community Name, no FIRM information will be displayed.
FIRM information is required for project closeout so communities are
required to be selected for flood type projects.

Select the community you wish to add. The community name is now
displayed and a blank row is displayed under the section Map Specific
Information For Selected Community.

Under the Panel Number column, click the drop-down button. The
Community Panel Numbers and their corresponding date are displayed.
(Figure 6-100).

ket Projects  Funding  Plans Repository  applications  Admin wWindow  Help

Eligiloi

G

Applicant Information. | Problem & Risk Dats | Project Infa | wwork Scheduls | Cost Estimats | Maton Sources | cost Ertectivensss |

ility: Review: Property Site Inventory I | Authorization

Number of Properties in Project: | 1

Ownerlnfe | MT Propeny Site | Property Infe | Flood Zone Designation | MFIP Info | Hazard Tupe FIRM Info | Fropery Site F|
Property ID: 1

Harme Damaged Address ity State ZIP Property I0
FwRE, BRETT VWELACH LARE

Aadd

Delete I

. Map Specific Inf tion For

Co ity
Panel Mumker 1 Dt | Add I

=l Delets |
0234 0Z/02/200:

1
1

20147 044107200
555 041 0/200

0356 Q1 05200 Edit Pansls |

Save | Mty | Sukmit |

Figure 6-100: Map Specific Information for Selected Community
Select the Panel Number you wish to add.

If the Panel Number you wish to add is not in the selection list, click the
ADD button in the Map Specific Information section. Click Edit Panels. A
Panels dialog box is displayed.

Click the NEW button. A blank row is displayed (Figure 6-101).
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mPanels for ks |
Panel Nr | Panel Date New
0270252005
Delete
|EI£IIIJIJIEIEIEI£I
0K
Cancel

Figure 6-101: Panel Dialog Box

h. Enter a FIRM Panel Number and the date from the actual FIRM map
(Figure 6-102).

R - |
Panel Nr ! Panel Date New
1047102007
e IITIIIIITIREI—————~ DeletE
10234 02/02/2005
oK |
Cancel |

Figure 6-102: New FIRM Panel Number and Date Added

16.Click the OK button. The newly-added FIRM Panel Number is now
available for selection.

17.Complete your Panel Number selections.
18.0n the bottom left part of the tab, click the SAVE button.

19.Click the Property Site Funding sub-tab (Figure 6-103). Enter the
information listed in Table 6-15.
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Applicart Informati | Probiem & Risk Deta | Project Info | Wark Schedule | Cost Estimate | Match Sources Cost Effectiveness Maintenance Assurance Public Notice | Attachmerts |
Eligibiity Reviews  Property Site Inuentory | | Authorization |
Number of Properties in Project: 1 :I
Hame Damaged Address city State  ZIP Prpty D add
FAVRE, BRETT ANE
Delate
Print
Owmer Info | MT Property Site | Praperty Infa | Fload Zane Designation HFIP Info | Hazard Type | FIRM Info  Property Site Funding | e |
Property D 1
MT Property Site - Funds Paid? [es =
MT Progerty Site - Funds Proposed 3245,600 Dste Funds Proposed: | 0410112012
Owner Accepte ed Funds? [ves =]  Dete Owner Responded to Proposal: | D4A 42012
Owner Appesled Proposal? = Dite Owmer Appealect: [ 0D/D0ODO0
Actual Amourt Paid @ 'ﬁﬁﬂSIEDD Date Actual Amourt Paid @ | 05012012
Purple = Required before Proiect Closeout. hd|
swe | wveny | suemt | smerd | cose |

Figure 6-103: Mitigation >Projects >Application Development >
Property Site Inventory >Property Site Funding Sub-tab

Table 6-15: Property Site Funding Data Fields

DATA FIELD ‘ INFORMATION TO BE ENTERED

MT Property Site -
Funds Paid?

WERE Federal funds expended for the property’s
mitigation? Select one of the following:

e Yes
e NoO

MT Property Site -
Funds Proposed

Dollar amount offered to Owner.

Date Funds Proposed

Date the dollar amount was offered to Owner.

Owner Accepted
Proposed Funds?

Did the Owner accept proposed funds? Select one of the
following:

Yes
Pending
No
Unknown

Date Owner Responded
to Proposal

Date the Owner responded.
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DATA FIELD ‘ INFORMATION TO BE ENTERED

Owner Appealed If the Owner did not accept proposed funds, did Owner
Proposal? appeal the proposal? Select one of the following:

e Yes

e No

e Unknown

Date Owner Appealed Date the Owner appealed.

Actual Amount Paid Amount paid to Owner.
Date Actual Amount Date amount was paid to Owner.
Paid

20.Click the Narrative sub-tab (Figure 6-104). To add Property Site Inventory
Narrative information, complete the following steps.

File Disaster Projects Funding Plans Repository  Applications  Admin  Window  Help
N I
ChgDizacter ChgGroup  Flane NENIS Exit
Applicant Information | Problem & Risk Data I Project Info I Work Schedule I Cost Estimate Match Sources Cost Effectiveness Mairtenance Assurance Pubilic Motice Attachiments I
Eligibiity Review:  Property Site Inventory | | Authorization |
Humber of Properties in Project: 1 j
i State  ZIP  PrptyID Add
FAWRE, BRETT
Delete
Fiint
Owner Infa I MT Property Site I Property Infa | Flood Zone Designation MNFIP Info | Hazard Type FIRM Info Propety Site Funding Narrative |
Property [D: 1
Select to Display
’7(' Legal Description (* Comment
omments about the property May 1, 201 2-EGARREN-0441/2012 21:00 GMT ;I
Save erify | Submit | Amend Cloze |

Figure 6-104: Mitigation >Projects >Application Development >
Property Site Inventory >Narrative Sub-tab

a. Click the radio button to select either Legal Description or Comment.
b. Double-click inside the text area. The Comment Editor is displayed.

c. Enter your text in the Comment Editor.
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d. Click the OK button. The text you entered is displayed on the Narrative
tab. The system appends your User Name, the date and time to the end of

the text.
e. On the bottom left part of the tab, click the SAVE button.
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Task 13B: Export, Update and Import the PSI Information

This feature allows a user to export the PSI information from NEMIS HMGP to a
spreadsheet. The user can then update the information on the spreadsheet, or add new
properties or both and then import the spreadsheet back into the project application.

1. Click the Property Site Inventory tab (Figure 6-105).

File Disaster Projects Funding Plans Repository  Applications  Admin  Window  Help

“E@Ej%ﬂ@

Chq Dizaster Chy Group Planz NEMIE Exit

“HMGP APPLICATION: DISASTER #: 9047 FEMAPROJ#:7-R APPLICATIONID: 7 AMENDMENT #: 4

Applicant Information | Praklem & Rizk Data | Praject Infa | Wark Schedule | Cozt Estimate | Match Sources | Cozt Effectiveness | Maintenance Assurance |

PublicNotce | Atachmerts | Eighiy Review  Property Ste Inventory | | autrorizaion | checkist |
Number of Properties in Pruject:l Add i
Hame Damaged Address Delete
WINDHAM, RARNDY EEEEIEI MANGROVE Sort
Export
Irnpart
Pirt
Owner Info |MT Property Site | Praperty Infa | Flood Zone Designation | NFIP Info | Hazard Type | FIRM Info | Property Site Funding | Narrative |
Property I 1

Figure 6-105: Mitigation >Projects >Application Development >
Property Site Inventory Tab

2. Click the Export button. The Select File window will appear (Figure 6-106)

CAUTION: There must be at least one property entered in the PSI of the project
(Task 13A). You cannot export a blank spreadsheet; if there are no
properties in the PSI, the following Error message will appear: There
are no properties in the project status to export.

Seleck File

Look jn: I[I_.ﬁ' Desktop

DM';.-' Docurnenks

J‘ M Cormpuker

h} My Mebwork Places

LMY SPREADSHEETS

@IVV Test Praperky Site Inv . x5LS
IEIJI'-.-'\-'TEST EXPORT PROP SITE IMNY,. XLS

File name: |51 20 PSI E=pory | Open I
Files of lwpe:  |Ewcel Files [*<LS) | Cancel |
A

Figure 6-106: Mitigation >Projects >Application Development >PSI Tab>
Export >Select File Window
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3. ldentify the location where you want to save the spreadsheet. In the File Name
field, type a file name for the new exported PSI spreadsheet. If successful, the
following PSI Export message will appear (Figure 6-107):

PSI Export

File is located in folder "C:Documents and Settings\egarren|Deskioplal20 PSI Expork, 5L3",

i l) Export completed successfully,
- Total number of properties exported: 11,

Figure 6-107: PSI Export Message — Export completed successfully

4. Select OK. Navigate to where the spreadsheet was exported and open the
spreadsheet.

NOTE: The spreadsheet will list the properties that were exported in numerical
order by Property ID in the first column. The spreadsheet column
headers are color-coded in line with the system. Green = required to
submit project, Purple = required before project closeout, Navy =
Property Attribute, Red = both required before project closeout and a
property attribute. The spreadsheet itself has several validations
included. Filling out the spreadsheet as completely and accurately as
possible is the key to a successful import of the data and to maintaining
the integrity of the property site inventory. Everything possible should be
done to avoid exporting and importing the spreadsheet multiple times.
Comments and Legal Descriptions exported will be imported again
creating duplicate records. To avoid duplicate entries delete all
previously entered comments and Legal Descriptions exported.

5. Update the spreadsheet as needed. Certain fields in the spreadsheet must be
entered as formatted by the spreadsheet; for example, if you enter four digits for
the telephone area code instead of three, the spreadsheet will generate its own
warning messages. You must correct the data entry before proceeding.

6. The following fields are required for a successful import; NEMIS HMGP error
messages reference the row number of the missing data.

a) First and last name — Both are required fields. An Error message will be
displayed if one or both of these fields is blank.

b) Damaged Address Line 1 — An entry in this field is required.
c) City, State and Zip — These are required fields for new and edited entries.

d) County — If the county is missing, no error screen will be generated. However
if a county is entered, as required before closeout, the system will compare
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7.

f)

9)

the entry to the county records for the state and if not on the list or spelled
incorrectly, an Invalid County error message will be displayed.

Phone Type — If the phone number is entered without a Phone Type, an
error message will be displayed.

Hazard -- The hazard the property is exposed to is required for import. If
missing or incorrect, you will receive an error message.

Comments and Legal Description — While comments are not required,

existing comments are exported, and if they remain in the spreadsheet, they
will be imported along with the rest of the data. If a spreadsheet is exported
and imported enough times, the comments will be entered exponentially and

exceed the maximum allowed characters. To ensure this does not happen
and to ensure comments are not repeated, it is best to delete the legal
description and especially the comments from the spreadsheet after export
and only enter any new comments you wish to have imported with edited or
newly added property records.

The export/import feature is designed to function the same way as the
system. The status of the amendment being edited determines if you can
import new properties or only edits to existing properties. For example:

a) A project for which the amendment has already been approved (Figure 6-
108) will allow for an export and an import, but because the Add button is
not lit you will only be able to edit and import the exported records. You
will not be able to import any new records. Attempting to do so will result
in the following error message: Project Eligibility has been completed; new
Property is not allowed to be added to this project.

Applicant Information | Problem & Rizk Data | Project Info | Wiork Schedule I Cost Estimate | Match Sources | Cost Effectiveness haintenance Assurance

Property Site Inventory | | Autharization |
Number of Properties in Pruject:l 2 Add
Eal Damaged Address City State  ZIP | Property D Delete

BART, ROBERT 2206 EMERALD ISLE JACKSON MS Soit

OMES, BOBBY [345 LILLIE LANE BIL Okl S 35582 1

“HMGP APPLICATION: DISASTER #: 9045 FEMA PROJ #: 19-R APPLICATIONID: 19 AMENDMENT #: 0

Pririt

b)

Figure 6-108: Project with Amendment Approved, Add Button Grayed
out and Export and Import Buttons Active

A project amendment that has been approved (or otherwise disposed) and
now has a higher amendment (Figure 6-109) can be exported but not
imported. Use the highest amendment when exporting and importing.
However, if the highest amendment is not in pending status, you will only be
able to import edited existing records. Any attempt to import new properties
when the Add button is not lit will result in an error.
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JORES, SRR

ORES, BOBBEY

Applicant Information | Problem & Risk Data | Project Info I Wyiork Schedule I Cost Estimate I Match Sources | Cost Effectiveness I Maintenance Assuran

Property Site Inventory | | Authorization |

Number of Properties in Prnjec‘t:l 2 Add
Hame Damaged Address City State ZIP | PropertyID _ Delte |

105 NORTH STREET JACKSON S ¥ Sort

[345 LILLIE LAME = = 39562 1 £ "
Expaor

Iripart

Prirt

c)

L]
1{) Property already exists in the project - row 3, please use 'Export’ and update the spreadsheet as required.
e

Figure 6-109: Project File with a Higher Amendment, Export Only

When importing a spreadsheet, any new properties will be compared to those
already existing in the project. If an exact match is found, the import will be
halted and a message similar to this will appear (Figure 6-110): Property
already exists in the project. Please note that only exact matches are
identified, so if any differences exist such as a slightly different zip code or a
damaged address line 2 in one record or not in the other, the record will not
be identified as a duplicate and will be allowed to import. While the message
states to export and update the spreadsheet as required, it may only be
necessary to update the existing spreadsheet by editing or removing the
duplicate entry and then attempting the import again.

8.

d)

Figure 6-110: Error Message — Duplicate Property

If after an export properties are deleted from the PSI in the system,
attempting to import a spreadsheet that has a property ID that no longer
exists in the system will result in an error message: Property does not exist
in the project. It will not be possible to import the spreadsheet and it will be
necessary to export the current PSI data and edit the existing records or add
new records in the system if applicable. The Property ID deleted from the PSI
will not be regenerated, leaving a void in the Property ID records.

Import the updated spreadsheet into NEMIS HMGP

a)

b)

Verify that the spreadsheet is complete and accurate, and that new property
locations are correctly added to the spreadsheet. This is very important to do
before importing the updated spreadsheet into NEMIS HMGP.

Import the spreadsheet into the existing PSI. The process is similar to the
export process except that you will select the Import button, and when the
Select File screen appears, navigate to the updated spreadsheet you wish to
import and either double click on the file or highlight the file and select Open.
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9. If the import is successful, you will receive a PSI Import message indicating the
Import/Update completed successfully (Figure 6-111). Select OK.

PSI Inmpork

Toktal number of properties imporked: 1.

iI) ImportfUpdakte completed successFully.
- Total number of properties updated: 16,

Figure 6-111: PSI Successful Import Message

CAUTION: Please note that if the number of properties imported is less that the

number entered in the spreadsheet, one or more of the records was
missing required information for the property and that record and any
entered below the incorrect record will not be imported. Since edited
records were imported and some new records were possibly imported, it
will be necessary to export the newly updated PSI again for additional
edits and new records to be succesfully imported. If you save the new
export with a new name, it will be possible to copy new property records
from the old spreadsheet to the new one and then edit the copied data to
meet the import requirements.

HINT: Users are encouraged to test this PSI export/import process in TDL prior

to attempting in production to get familiarized with the process.
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Task 14: Enter Latitude and Longitude Information

1. Click the Lat/Lon tab (Figure 6-112).

File Disaster Projects Funding Plans Repository  Applications  Admin  Window  Help

H © B & [k

ChgDizaster Chg Greup  Planz NEMIS Exit

“HMGP APPLICATION: DISASTER #: 7519 FEMA PROI#: - APPLICATIONID: 16 AMENDMENT #:0

Applicant Information | Prablem & Risk Data | Praject Infa |W0rk Schedule | Cost Estimate | Match Sources | Cost Effectivenass
Public Natice | Atachments | Eligibilty Review | | Authorizstion |

Click for sample lstitude and longitude == Sample ...

Latitude | Longitude I LatlLon Yerification I Comment

Maintenance Assurance |

Purple = Required before Project Closeout.

Mew Delete

Save | ety | Submit |

Amencd | Cloze |

Figure 6-112: Mitigation >Projects >Application Development >Lat/Lon Tab

2. Click the SAMPLE button in the upper part of the tab. A diagram explaining
Latitude and Longitude entries and a sample entry is displayed (Figure 6-

113).

Latdlon Verification Comment

¥fiLatitude and Longitude [ <]

[ N

Latitude ="+"for Morth and " for South

Longitude ="' for West and "'+ far East

Data entry requires a'-" entered for each negative entiy. A"+ sign is not required befare
positive entries. A sample latitude and longitude iz as fallovs:

542 Franklin Street = Latitude = 37.77215
San Franciscao, California  ~— Longitude = -122.43014

The latitude and longitude: reflects the Incation of the main structure on the properly

The latitude and longitude fields within the project ication in icati section
of HMGP, HMGP-Historical and FMA are decimal degrees.
11 These figlds will not accept Istitude and longtude values in the form of degrees, minutes, seconds nor will it
altomatically convert them to decimal degrees.
21 Any values that you want to enter in the degrees, minutes, seconds format must be converted to decimal
degrees before entering them.
3) This value may be at the County level (4 digits), although mare accurate values are preferred
For comments regarding latitude and longitude, please include the following:
11 For proiection, indicate Morth American Datum (NAD) 83 or YWorld Geodetic System (WGES) 84
21 For accuracy, indicate Lowy, Very Lowy, Moderate or value in Feet or Meters
31VWhen using street address, exclude P.O. boxes and 911 addresses

Fiint Class

Purple = Required before Project Closeout.

e Delete

Seve

Amend Close
=

Figure 6-113: Sample Latitude/Longitude Information

3. On the bottom left part of the Lat/Lon tab, click the NEW button. A new row

for adding Lat/Lon information is displayed.
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4. Enter the Latitude and Longitude information in decimal degrees.

CAUTION: The latitude and longitude fields in HMGP - Application Development
are decimal degrees. These fields will NOT accept latitude and
longitude values in the form of degrees, minutes, and seconds, nor will
it automatically convert them to decimal degrees. The user must
convert the degrees, minutes and seconds to decimal degrees for entry
into these fields (see Table 6-16). The latitude and longitude fields
also will not accept State Plan Coordinates. See your GIS specialist for
assistance.

Table 6-16: How to Convert from Degrees-Minutes-Seconds to
Decimal Degrees

Degrees |Minutes/60 | Seconds/3600 Add Total Decimal
Degrees

39 36/60=0.600 |30/3600=0.00833 |39+0.600+0.00833 39.608330

-105 15/60=0.250 |45/3600=0.0125 |105+0.250+0.0125 -105.262500

*Divide Each Value By The Number of Minutes Or Seconds In A Degree
Example: 39° 36’ 30," -105° 15’ 45”

NOTE: The minus sign is not a mathematic operational symbol but rather
signifies the quadrant on the globe. Therefore, the minus sign was not
added to the number until after the totaling of the minutes and seconds
to the degrees.

HINT: The graphic below (Figure 6-114) provides the general rule for using the
(+) and (-) signs to signify the quadrant location on the globe.

DO
Negative Longitude Positive Longitude
Positive Latitude Positive Latitude
h
=
=
0° EQUATOR 0°
=
m
=
=4
-l
Negative Longitude Z Ppositive Longitude
Negative Latitude Negative Latitude
DD

Figure 114: General Rule for Using the + and - Signs
Reference: ESRI On-Line Course — The Basics of Map Projections, Lesson One
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5. The Lat/Lon Verification field is a drop-down list of likely sources of the data.
Select the source of the Lat/Lon data.
6. Double-click inside the Comment field. The Comment Editor is displayed.

NOTE: Some examples of comments are:

Coordinate system used (NAD 83, WGS 84, etc.)
Accuracy level (very low, low, moderate, accurate, very accurate
Accuracy value in feet or meters)

Source (especially if the Lat/Lon Verification selected is “Other”)

7. On the bottom left part of the Lat/Lon tab, click the SAVE button.
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Task 15: Enter Authorization Information

1. Click the Authorization tab. The Plan Information sub-tab is displayed by
default (Figure 6-115).

File Disaster Projecks Funding Flans Repository  Applications  Admin  Window  Help

(=] @ =] & ) &

Chg Disaster Chy Group Plans NENIE Exit

Q%HMEP APPLICATION: DISASTER #: 7519 FEMA PROJ1 #: - APPLICATIONID: 16 AMENDMENT &: 0

applicart Information | Problem & Risk Data | Projectinfo | work Schedule | Cost Estimate | Matoh Sources

Maintenance Assurance | Public Motice | Attachments | Eligibility Rewview I

| Lataon |
Application Status: I Application Submizsion Date: I 0000000
Final Project Approval Date: I 0000/0000 Application Received Date: I 00000000
Plan Information I Freparation |nfarmation I I FEMA Beview I

Disaster Declaration Date: I 02182010
— Grantee HMGP Administrative Plan

Approval I 00/00,/0000 Plan Due I 00/00/0000 Mo Grantee HMWGP Adminiztrative Plan information in detabase. Please enter

Date Date currert information. There must be an admin plan swith 5 valid aporoval date:
AFTER the disaster declaration date before any projects can be approved for

— Grantee Mitigation Plan
Plan Type EMH Revision Mr I 1
Plan Title I!Enate of Mizsissippi Multiit Plan_%3P2 Testing
2pryl Type [STANDERD aprviot [04/01/2005  Expire Ot |

— Subgrantee Mitigation Plan

Plan Type [-ocal Muftinazard Mtigation Plan Plan Title [SITY OF ANMA V3P2 TESTING PLAN

AprVID‘tI 06052002 I 05052007

Save I Werify | Submit |

Amenad I Cloze I

Figure 6-115: Mitigation >Projects >Application Development >
Authorization Tab

NOTE: All of the fields are auto-filled under the Plan Information sub-tab. If one
of the required plans has not been entered into NEMIS HMGP under Unit
4: (Manage the Mitigation Plans Repository), you will get a warning
message on the screen (see Figure 6-1116).

2. Click the Preparation Information sub-tab (Figure 6-116). Preparer and Title
are auto-filled from information on the Applicant Information screen. To enter
additional Preparation Information, complete Steps 2a - 2e.
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[[Efle " Gisaster Proiects  Funding  Plans Repository  applications  admin  sindow  Help

Figure 6-116: Mitigation >Projects >Application Development >
Authorization >Preparation Information Sub-tab

Enter the Authorized Applicant Agent’s Last Name, First Name, and Title
in the designated boxes. These are required fields.

Use the drop-down list to choose Yes or No for Applicant Signature on
File.

Enter the Authorized Grantee Official’'s Last Name and First Name in the
designated boxes. These are required fields.

Use the drop-down list to choose Yes or No for Grantee Official Signature
on File.

NEMIS HMGP enters the current date, but you can edit the date if
necessary.

CAUTION: If NO is selected in the Signature on File question, you will not be

allowed to submit the application.

3. Click the Managing Grantee Review sub-tab if it is not grayed out (Figure 6-
117). To add Managing Grantee Review information, complete Steps 3a - 3c.

Plan Information I Preparation Information Managing Grantee Review | FEMA Review I

Sign electronically, as Preparer andiar Reviewer, for each Review Type by clicking the icon to the right of the

Freparer and Reviewer fields, ar enter each field manually, including Review Date REVIEW
REVIEW TYPE | PREPARER | REVIEWER | DATE
ICATEX 1 REVIEWY EMITH, MATTHEW E [SMITH, MATTHEVY @ 08/30/2002
ICOST EFFECTIVEMESS REVIEW indham E inciharm @ 08/27/2002
PROJECT TYPE COMPLETEMESS REVIEWY tapleton E [EMITH, MATTHEVY E 05/30/2002
PROJECT CRITERIA COMPLETENESS REVIEW indham E lmith, matthesa Z 121972002
ICODE COMPLIANCE REWIEWY ISTAPLETON, CATHERINE E‘j stapleton E‘j 08/27/2002

C.

Figure 6-117: Mitigation >Projects >Application Development >
Authorization >Managing Grantee Review Sub-tab

For each Review Type, enter the Preparer and Reviewer names.

Click on the icon to the right of the Preparer and Reviewer box to have the
system automatically enter your User Name.

Enter the Review Date.
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4. Click the FEMA Review sub-tab (Figure 6-118).

Fle Disaster Projects Fundng  Plans Repository  Applcations  Admin wWindow  Help

8 2 ik

ChgDizazter ChqGroup  Flans  HEMIS Exit

“HMGP APPLICATION: DISASTER #: 7519 FEMA PROJ #: - APPLICATIONID: 16 AMENDMENT #: 0

Applicant Informstion | Proklem & Risk Data | Project Infio | Work Schedule | Cost Estimate | Match Sources | Cost Effectiveness Mairtenance Assurance Public: Motice | Attachments |

Eligibility Revigw | Broperty Site Inventary | Latlon At
Application Status: l— Applicstion Submission Date: W
Firval Project Approval Date: W Application Received Date: W
Plan Information | Preparation Infarmation | Wanagi Grantee Fesiew FEMA Review |
Date Approval
Review Type Reviewer /Approver Reviewed/Approved User Role Remdtn
Mittigation Analyst appointed by HMO | | 00/00/0000  FEMA HMO
Cost Review | | 000000 Cost Reviewer O
NEPA, Dacumenitaion Review | | 00/00/0000  FEMA Environmental Reviewer
Laws/EQs Review | [ 0000000 FEMA Environmental Reviewer
Erviranmental Officer Review | | 00/0M000  FEMA Environmentsl Officer [
Eligihilty Review | | comomoon me
FEMA, Project Approval Decision | | oomOm000 A |
Approval Decision Concurrence | [ o0mo/m00a - Hwo O
Final &pprovsl | | 00/00/0000  HMO for Regional Director
Regional Director |‘ | 00/00/0000 Final Project Approval D
Appesl 1 HMO
Appesl 2 HMO
Project Appeal Decision HMO
State HMGP Administrative Plan Approved 7 ()Yes ®@No SF_424 received 7 ()Yes @INo
Letter of Intert received ? (I ves ®no FIO Natified 7 (s o
Public Mews Release Date W

Save | Werify | Submit | Amend Close

Figure 6-118: Mitigation >Projects >Application Development >
Authorization >FEMA Review Sub-tab

NOTE: The fields will auto-fill as information is entered by FEMA personnel in
Unit 7: Manage Eligibility Determination.

Page 6-94 NEMIS HMGP User Manual MR 3.18.02




December 2015 Unit 6: Manage the HMGP Project Application

Task 16: Edit an Existing Project Application

NOTE: A project application can be edited up until FEMA has completed the
Eligibility Determination (Unit 7: Manage Eligibility Determination
Information).

NOTE: Once the project application has been approved or denied, the only task
permitted is to attach documents, as described in Task 11: Attach
Documents. To make other changes to an approved, denied, or withdrawn
project application, follow the instructions in Unit 8: Manage
Amendments.

1. On the MITIGATION menu bar, click Projects > Application Development.
A list of all projects (regardless of status) associated with the disaster number
is displayed (Figure 6-119).

KR NEMIS / HMGP Yersion 3.16.00 04,/26/2013

Fil= Disaster Projecks Funding Plans Repository  Applications  Admin  Window  Help
| D =] = =
Chyg Dizaster Chg Group Planz MERIS Exit
|Fema Proi ir| amendment nr|_aAppiic 0| suffix| ST | Region| Project Title | =
0 I 1S 4 Relocation of 45 Homes in Adams County
o 2 M= 4 Acguisition of 43 homes
[ | 0 E] | [Ms [ 4 [Special Project
[ o [ 4 [ ws[ & |
| =2 | o | & | R |MS | 4 Iﬁ'—\cquisitiun of 10 homes in Adams County
I ] | 1 | 5 [ R IMS| 4 |acquisition of 10 homes in Adams County
I ] | ] | 5 [ R [mS| 4 |acquisition of 10 homes in Adams County
I 1 | 0 | 5 [ R [MS | 4  [Structural Retrofit of EMa Office
I 1 | 1 | 5 [ R [MS | 4  [Structural Retrofit of Eia, Office
I I 0 I 7 IEENER
I I 0 I8 EENE
[ o 5 [ sl | B
U Bine Expand Sort | [R[= DIk I Cancel |
j | EErETCE | DT 2ra0T [ OSTSIOT |

Figure 6-119: Mitigation >Projects >Application Development >
Project List

2. Table 6-17 describes the information displayed on the Select Project screen.

Table 6-17: Select Project Data Fields

DATA FIELD ‘ INFORMATION DISPLAYED

Disaster Nr Official number assigned to the disaster by FEMA

FEMA Proj Nr Project application ID number assigned sequentially when
the application is submitted to FEMA.
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DATA FIELD ‘ INFORMATION DISPLAYED

Amendment Nr Sequential number assigned by the system. 0 is the
number assigned to the initial application, 1 is assigned to
the first amendment, etc.

Applic ID Number assigned by NEMIS HMGP or by the Grantee
when a new record is created
Suffix Type of funding requested. Codes include:
o R (Regular Project Funding)
e M (Grantee State Management Costs)
e F (Initiative Projects)
e P (Planning Projects)

Auto-filled by the system after FEMA Mitigation staff
complete Task 3 in Unit 7: Manage Eligibility Determination.

ST Two-letter State code
Region FEMA Region Number
Project Title Description of the project application

3. Highlight the project that you wish to edit. Click the OK button.

4. The twelve tabs of Application Development are displayed. The Applicant
Information tab is displayed by default.

5. Click the tab of the application information that you wish to edit.

NOTE: To edit Cost Estimate and Match Sources information, follow the
instructions in Task 7, Step 7.

CAUTION: If you are editing a project application that has been submitted, you
need to alert FEMA to these changes because the project may be in the
review process.

HINT: To identify the Mitigation Analyst assigned to this project application, go
to Mitigation > Projects > Eligibility Determination - In Process. Scroll to
the right to view the FEMA Reviewer for the applicable project
application. Contact that person via phone or email about the changes
you entered in the system.
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Task 17: Verify and Submit a Project Application

1. Click the Authorization tab. On the bottom left part of the tab, click the
VERIFY button.

2. If any required fields are empty, error messages will be displayed indicating

the missing field and the Application Development tab where you can enter
the missing information (Figure 6-120).

@ futhorized Grantee Cfficial signature must be on file with FEMA on Autharization tab,

Figure 6-120: Authorized Signature Missing Warning Message

3. Make the necessary corrections and click the VERIFY button again.

4. Table 6-18 provides a list of required fields and their location in Mitigation
>Projects> Application Development.

Table 6-18: Required Fields and System Location

REQUIRED INFORMATION ‘ APPLICATION DEVELOPMENT TAB
Grantee/Sub-grantee Applicant Information
Project Type Project Info
Project Title Project Info
Counties Project Info
Congressional Districts Project Info
Community Name Project Info
Hazard Type Project Info
At least one Work Schedule Item Work Schedule
At least one Cost Estimate Item Cost Estimate
At least one non-Federal share Line Item Match Sources
Cost Effectiveness Information for each Cost Effectiveness
Community
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REQUIRED INFORMATION

At least one Property Inventory:

Owner, Structure Type, Property Damage
Category, Foundation Type

APPLICATION DEVELOPMENT TAB

Property Site Inventory

NFIP Info:

Flood Source, Repetitive Loss Flag, Flood
Zone Code, Repetitive Loss Category

Property Site Inventory > NFIP Info Sub-
tab

Environmental Checklist for at least one
Alternative

Eligibility Review >Env Checklist Sub-tab

Authorized Applicant Agent and Authorized
Grantee Official Names, Titles and
signatures on file

Authorization

Project Reviewer

Eligibility Review > OverviewSub-tab

Eligibility Determination Criteria - Applicant,
Project type, Project Criteria

Eligibility Review-> OverviewSub-tab

Other Reviews - C/E Review, Code
Compliance, Mt Plan Conformance

Eligibility Review > OverviewSub-tab

Approval Recommendation

Eligibility Review >OverviewSub-tab

Table 6-19 lists attachments that are required for the project application.

Project applications may be submitted in NEMIS HMGP without these items
but these documents must be attached before FEMA's final approval in the
eligibility determination process (Unit 7: Manage Eligibility Determination).

Table 6-19: Required Project Application Attachments

DOCUMENTS

History, Alternatives, Proposed

Task 3: Attach Problem & Risk Data

TASK ‘

Actions

Project Description

Task 4: Enter Project Information

Maintenance Assurance

Task 9: Attach Maintenance Assurance Information
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For any missing attachment, you will get the following warning message
(Figure 6-121) when you click the VERIFY button:

Submit to FEMA B

The project dezcription musgt be attached prior to submigzion of thiz project. Please refer to
the Project [nformation tab. | pou are unable bo attach this you may sl submit the project

to FERA and forward thiz attachment to the FERMA regional office via mail.

Figure 6-121: Missing Required Attachment Message

6. Click the OK button. A message that all checks were completed successfully
is displayed (Figure 6-122).

Yerify

|

All checks completed successfully, except one or more required attachments [project
dezcription, maintenance, ete. ] were not found. [F pou are unable to attach these you may

gtill zubmit the project to FEMA and forward these attachments to the FERA regional office
wia mail.

Figure 6-122: Verification Complete Message
7. Click the OK button.

8. On the bottom left part of the tab, click the SUBMIT button. The Final
Submission dialog box is displayed (Figure 6-123).

NOTE: When you click the SUBMIT button, NEMIS HMGP will automatically verify
the application before displaying the Final Submission dialog box.

Submit To FEMA =]

& “'ou are about to gsubmit the application to FERMA.

Are you gure that pou would like to continue?

Figure 6-123: Final Submission Dialog Box
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9. Click the YES button. The project application is submitted to FEMA. A
message is displayed that the work packet for the Receipt and Delegate task
in the Eligibility Determination process was created (Figure 6-124).

Submit to FEMA E3

@ Wiorkpacket for Receipt and Delegate was succesfully created,

Figure 6-124: Work Packet Created Message

10.0n the bottom right part of the tab, click the CLOSE button.
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Task 18: Zero Out a Project

1. Click the Match Sources tab (Figure 6-125). Read the warning and click OK.

o

=

le Disaster Projects Funding Plans Repository Applications  Admin  Window  Help

“E@%ﬂe

Cha Disaster ChaGroup  NEMIS Exit

A pplicant Information | Prablem & Risk Data | Praject Info | Work Schedule | Cost Estimate Match Sources | Cost Effectiveness Maintenance: Assurance Public Notice | Atta

Total Project Cost Estimete: EEI Proposed Federal Share: F4125
Federal Share Percentage: 75 % Proposed Mon-Federal Share: $1,375

Hon-Federal Funding 10f2
Source Agency ILDCa\ j Funds Availshility Date | O8M 52011

Source Name |citv of Anna Funds Commitment Letter Date: [ 09m1.2011
Funding Type ICssh -

Other Funding
Type Descrigtion * |

% of
tem Kame Unit Gty Uit of Messure Uit Ceist Total Cost ]
Fny funds to cover eligible expenses. | 1(Ls ;Il 1000 | 31,000 [ 73%
Source Agency ILDEE\ j Funds Availshility Date | 081152011

Source Mame Iﬁdﬁms Courty Funds Commitment Letter Date : | 09012011
Funding Type |Admws~trauun -

Ottrer Funding
Type Description : |

% ot
ttem Name Unit it Untt of Messure Unit Cost Tatal Cost Non-Fed
I!Stsfl time to complete administrative work | 25[HR LI | 15 | 5375 [ 27%

Grand Total Cost I $1,375 | 100%
Reference Cost Codes
Pafe  H: i
Mew Delete ’7 __ Dilr |

Save | Verify | submit |

Figure 6-125: Mitigation >Projects >
Application Development >Match Sources Tab

Select an item by clicking inside any of the Non-Federal funding fields. On the
bottom left part of the tab, click the DELETE button.

Repeat Step 2 for additional items that you wish to delete.
Click the Cost Estimate tab and delete all line items.
On the bottom left part of the Cost Estimate tab, click the SAVE button.

Still in the Cost Estimate tab, click the NEW button. A new row for Cost
Estimate information is displayed.

Enter a line item with a Unit Quantity of "1" and a Unit Cost of "0."
On the bottom left part of the tab, click the SAVE button.

The message "Data has been saved" is displayed. Click the OK button on the
message box.

10.Click the Match Sources tab.
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11.0n the bottom left part of the tab, click the NEW button. A set of data fields for
Non-Federal Funding information is displayed.

12.Enter the information in the required data fields (boxes are shaded green). In
the Unit Cost column, you must enter "0."

13.0n the bottom left part of the tab, click the SAVE button. The message "Data
has been saved" is displayed.

14.Click the OK button on the message box.
15.0n the bottom right part of the tab, click the CLOSE button.
16. Verify that the task has been done correctly by completing the following steps.

a. On the MITIGATION menu bar, click on Projects>Eligibility Determination
> View All. The project list is displayed.

b. Select the project that has just been zeroed out. Click the OK button.

c. Click the Cost Review tab. The project dollar amounts should now be "$0."
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Task 19: Copy an Un-submitted Project to a More Recent Disaster

FEMA personnel with the HMO position now have the option of copying an un-
submitted application from one disaster to a more recent disaster. This will reduce or
eliminate the need to re-enter an application that was not funded in one disaster but can
be submitted to a more recent disaster for federal eligibility.

Users who are not FEMA personnel with the HMO position can either re-enter the
application in its entirety under the more recent disaster, or contact the FEMA regional
office for assistance.

If the user chooses to copy a project from one disaster to a more recent disaster, the
following prerequisites must be met:

e The status of the more recent disaster where the application shall be copied from
is OPEN. If the disaster is CLOSED, the system will generate the following
Project Copy message: You must select an open disaster to copy the
project.

e The status of the project that is to be copied must be OPEN. If the project
selected is CLOSED, the system will generate the following Project Copy
message: You must select an open project for the copy.

e The project that is to be copied must NOT be obligated. If the project selected for
copy is obligated for $1 or more, the system will generate the following Project
Copy message: There is already an accepted obligation for this project. This
project cannot be copied.

e The Grantee State or Tribe being used when copying for both the original
disaster and the more recent disaster must be the same. If they are not the
same, the system will generate the following ERROR message: You must use a
disaster declared in the same state when copying an application.

e The project must be copied to a disaster with a more recent declaration date than
the declaration date of the original disaster. If this is not the case, the system will
generate the following Project Copy message: You must select different
disaster with later declaration date to copy the project.

If every prerequisite above is met, the process to copy an application from one disaster
to another is as follows.

1. On the MITIGATION menu, select Projects > Application Development. Make
sure you are on the disaster where the original application is. When the
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Application Development screen appears, select or highlight the project to be
copied, and then click on the COPY button (Figure 6-126).

ﬂs:lrt_t Project: Application Development Disaster 9045

Ferma Proj Hr| Amendment tir] Applic 10 | Sufrx| 5T | Region| Project Title | B

P T [ 12 [P [ws[ &4 Pansr2

[ 13 [ 0 [ 13 [P [Ms[ & Panns

[ [ 0 [ & [P MS[4 Panms

[ 155 [ o0 [ 1B [P [MS[ 4 pLAN#i5

[ | o | 1B [P [MS[ 4 Pan#ie

17 [ o [ 17 [P [MS[ 4 [lan#7

7 [ v [ 17 [P [MS[ & Pansr

| 18 | 0 [ [P [Ms[ 4 Pan#s

T [18 [P [MS[ 4 [Plan#s

18 [ 0 [ 1@ [R [MS[ & [TestProjectfor PR3.18

1 [ 1 [ 18 [Rr [MS[ 4 [TestProjectfor GPR3.18

_nm-mn Project 1o be transfermed to S047 B
Pt | Expand Son | — oy | wew [ [ ok ] cwem |

Figure 6-126: Mitigation >Projects > Application Development >Copy

2. The Select Disaster screen will appear. Enter or select the new disaster number
to which the project is to be copied and select OK (Figure 6-127).

§# Select Disaster [ X
~Select a disaster

Disaster: [3047] | State: [MS Declaration Type: [DR

Summary: \

N

OK Refresh

Figure 6-127: Mitigation >Projects > Application Development >
Copy >Select Disaster Screen

3. The following Project Copy message will be displayed: Subgrantee Mitigation
Plan Type, Subgrantee Mitigation Plan Title, Subgrantee Mitigation Plan
Approval Date, Subgrantee Mitigation Plan Expiration Date and Eligibility
Review — Overview tab information, will not be copied to the new
application.

4. Select OK. If successful, a message will be displayed confirming that the project
copied over to the new disaster with a new application ID (Figure 6-128).
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Project Copy

-
\_l ) 9045 Disaster and Application 99999 Copied ko Disaster 9047 new Application 10is 100000

Figure 6-128: Confirmation of Project Copied to a New Disaster

5. The project will now appear in the Select Project: Application Development
(Figure 6-129). Change the name of the project, add the Subgrantee plan
information, complete the eligibility review and make any additional edits before
submitting the project to federal eligibility.

bq'ﬁSelect Project: Application Development Disaster 9047 =
Fema Proj Hr| Amendment Hr| Applic I0 | Suffiz| ST | Region| Project Title | A
| 4 | 0 | 4 | =] IE| 4 Iﬂ'l.dam County Multi-Hazard Mitigation Plan Update
I 0 [8 [P [MS[ 4 [TheCity of Bay Springs Multi-Hazard Mitigation Plan
| B | 0 G | F Iﬁl 4 |State of MS Code Program
| B | 1 G | F Iﬁl 4 |State of MS Code Program
[ 7 [ © [ 7 R |MS[ 4 [Testfor3.17.03
[ 7 [ 1 [ 7 R |MS[ 4 [Testfor3.17.03
[ 7 [ 2 [ 7 R |MS[ 4 [Testfor3.17.03
[ 7 [ 3 [ 7 R [MS[ 4 f[Testfor3.17.03
| | 0 [ 8 | [ms [ 4 fEST# FOR3 1703
| | 0 | 99993 | [Ms [ 4 [Transfer this Project to DR 9046 Test
0 0 4 ||Praj d fram DR 9045 to DR 2047
0 100001 f= | 4  |Project to be transferred to 9047 =
Pririt | Expand Sort | Copy | ey | ’TI Cancel

Figure 6-129: Select Project: Application Development Screen
Showing Project Copied to the New Disaster
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References for Manage Project Application

Flood Zone Codes

Project Type Codes

Property Site Inventory - Hazard Types
Property Site Inventory - Property Actions
Available Reports
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Table 6-20: Flood Zone Codes

CATEGORY CODE DESCRIPTION

C, X Area of minimal flood hazards

B, X Area of moderate flood hazards

N Area of moderate mudslide (i.e., mudflow) hazards

AR Area of special flood hazard that results from the decertification of a
previously accredited flood protection system that is determined to be in
the process of being restored to provide a 100-year or greater level of
flood protection

A99 Area of special flood hazard where enough progress has been made on
a protective system, such as dikes, dams, and levees, to consider it
complete for insurance rating purposes

Al1-30, AE Area of special flood hazard with water surface elevations determined

A Area of special flood hazard without water surface elevations
determined

A0 Area of special flood hazards having shallow water depths and/or
unpredictable flow paths between one and three feet

VO Area of special flood hazards having shallow water depths and/or
unpredictable flow paths between one and three feet and with velocity

AH Area of special flood hazard having shallow water depths and/or
unpredictable flow paths between one and three feet, and with water
surface elevations determined

V1-30, VE Area of special flood hazards with water surface elevations determined,
and with velocity, that is inundated by tidal floods (coast high hazard
area)

Vv Area of special flood hazards without water surface elevations
determined, and with velocity, that is inundated by tidal floods (coast
high hazard area)

E Area of special flood-related erosion hazards

M Area of special mudslide (i.e., mudflow) hazards

D Area of undetermined but possible flood hazards

P Area of undetermined, but possible mudslide hazards

Other Specify in comments
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Project Type Codes

To see the list of Project Types available complete the following steps:

1. On the Mitigation menu bar, click Admin > Project Type Matrix Information

(Figure 6-130).

Figure 6-130: Mitigation > Admin > Project Type Matrix Information

2. Alist of project types is displayed (Figure 6-131). You may use any that are
checked under the HMGP column. Check this table often because the
information is subject to change.

The table displays other pertinent information such as:

Code descriptions

Whether the code is a legacy code (i.e., a code use in pre-3.0 NEMIS
HMGP version releases)

Whether the code requires a PSI

Whether the code is applicable to HMGP, FMA, or the HMGP
Historical Database

Predecessor code (for example, Code 90.1, Mitigation Plan —Local
Multi-hazard Mitigation Plan, is the predecessor of Code 91.1, Local
Multi-hazard Mitigation Plan)
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MNEMIS & eGrants?  =Grants Grant Type. I I

Pr T Matrix Information
NEMIS
code DRSEHpHoT Legaoy [NEMIS|ECRNT| pian | smc | Huor lﬁ‘,‘; Pl RoEvR] O
2011 |Relocation of Private Structures - Riverine [ =a (= == 010141901
201.2 |Relocation of Private Structures - Coastal (] I XI|IO 0 X IRKRIEIXR 01/0141901
2013 |Relocation of Public Structures - Riverine (] N X |00 X |IK XX 01011901
201 .4 |Relocation of Public Structures - Coastal [} = Ol O = =<l =] 01014901
201.5 |Relocation of Private Structures - Erosion [} mE . =A== 01/01/1901
201 6 |Relocation of Private Structures - Landslide [] X = OO XD X| XK 010141901
201 .7 |Relocation of Private Structures - Snow Avalanche [ ] ] ] OIXxKI X 010141901
201.8 |Relocation of Public Structures - Erosion ] = =) 0| O N IX XX 01014901
201.9 |Relocation of Public Structures - Landslide ] [ [=4] J ] HIOXK XK 01011901
201 10 |Relocation of Public Structures - Snow Avalanche [ Ol () 01011901
201.1A|RETRO - Relocation of Private Structures - Riverine (] = |m =)= (= =] 0101190
201.24|RETRO - Relocation of Private Structures - Coastal [ =) [ OOl Xx|(O|0O| 0O o101 1901
201 .32 |RETRO - Relocation of Public Structures - Riverine [ ] (] Ol a OlOgold 010141901
201 .45 |RETRO - Relocation of Public Structures - Coastal [} =a = mE X |IOl OO 010141901
202.1 |Elevation of Private Structures - Riverine ] = <] OO0 X |IK|IXK| XK 01/0171901
202 2 |Elevation of Private Structures - Coastal [] = 1] ] == o1 /014901
202.3 |Elevation of Public Structures - Riverine ] = OO0 @ I|IX XX 01014190
202.4 |Elevation of Public Structures - Coastal ] B = J ] == = 01011901
202 5 |Elevated Foundation System - Pilot (P205-080-01 ] ] | O | 01012010
202.14|RETRO - Elevation of Private Structures - Riverine [] = ] O X [0 01011901
202.24|RETRO - Elevation of Private Structures - Coastal ] = [] OO0 X |0 0O O 010141901
202.3A|RETRO - Elevation of Public Structures - Riverine [} = O O Hl|O OO 01011901
202 .44 |RETRO - Elevation of Public Structures - Coastal [} =< [} Ol O X IOl O O 010141901
203.1 |vwet Floodproofing Private Structures - Riverine (] X I X0 0 XIKIXK|IRXK 01011901
203.2 |wet Floodproofing Private Structures - Coastal [ =] OO0 X |IK|XK| XK 010141901
203.3 |wet Floodproofing Public Structures - Riverine [} = | O === 010141901
203.4 |vWet Floodproofing Public Structures - Coastal || = = O O == 010141901
203.14|RETRO - Wet Floodproofing Private Structures - Riverine [] = ] OO X |0 O] Cd 0140141901
203 .2A|RETRO - Wet Floodproofing Private Structures - Coastal [ ] 1] ] ] [] ] ] 010111901
203.34|RETRO - Wet Floodproofing Public Structures - Riverine ] = ] O] O = | O | 01014901
203.4A|RETRO - Wet Floodproofing Public Structures - Coastal [} [ = (-] RO OO 01011901
204 1 |Dry Floodproofing Private Structures - Riverine (Commercial) (| () (I [=4] (=4 o 01 A8
204 .2 |Dry Floodproofing Private Structures - Coastal (Commercial) (] X I X0 0 XIRKRIX|I XK 010141901
204.3 |Dry Floodproofing Public Structures - Riverine [ O O == 010141901
204 .4 |Dry Floodproofing Public Structures - Coastal [} = = Ol O = === 01014901
204 5 |Dry Floodproofing Private Structures - Riverine (Residential-Historic) [} [=4] [=4] Ol O OolOol gl Od 01/01/2007
204 6 |Dry Floodproofing Private Structures - Coastal (Residertial-Historic) (] OOl alolO]fd 0140172007
204 14|RETRO - Dry Floodproofing Private Structures - Riverine (Commercial) [ < [ | O [y . 010141301
204 .24 |RETRO - Dry Floodproofing Private Structures - Coastal (Commercial) [ ] O|lOo|lx|(O|l0O| O 01014190
204 .32 |RETRO - Dry Floodproofing Public Structures - Riverine [} = [} O O [ mi - 01/01/1901
204 42 |RETRO - Dry Floodproofing Public Structures - Coastal [] = ] 1| X | J| ] 010141901
204 54 |RETRO - Dry Floodproofing Private Structures - Riverine (Residential-Historic) [] ] O X [O O] 01/01/2007
204.64|RETRO - Dry Floodproofing Private Structures - Coastal (Residential-Historic) ] = ] O] O | O | O 01/01/2007
2051 |Retrofitting Private Structures - Wildfire [} = =a Ol O HIOXK XK 010111901
205 2 |Retrofitting Public Structures - Wildfire [} =< =a Ol O Ol X 2 010141901

Figure 6-131: Project Type Matrix
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Property Site Inventory - Hazard Types

Biological
Chemical

Civil Unrest
Coastal Storm
Crop Losses
Dam/Levee Break
Drought
Earthquake

Fire

Fishing Losses
Flood

Freezing

Human Cause
Hurricane

Land Subsidence
Mud/Landslide

Nuclear

Severe Ice Storm
Severe Storm(s)
Snow

Special events
Terrorist

Tornado

Toxic Substances
Tropical Cyclones
Tsunami
Typhoon
Volcano

Wind Storms
Other (Specify in

comments)
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Property Site Inventory - Property Actions

Acquisition of Vacant Land
Acquisition/Démolition
Acquisition/Relocation
Elevation

Flood-proofed

Other (Specify in comments)
Safe Room/Wind Shelter
Seismic Retrofit

Wildfire Retrofit

Wind Retrofit
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Available Reports

To track and document the process of Managing Project Applications, the
following reports can be generated, as described in Unit 14 - Generate Standard
HMGP Reports:

Project Cost Line Item Report
Non-Federal Share Fund Report
Property Site Inventory Report
Application Development Report
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